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Résumé 

L'étude se concentre sur la conception d'antennes patchs planaires, des antennes à 

faible profil largement utilisées dans les applications de communication sans fil en raison 

de leur compacité et de leur facilité de fabrication. Dans cette recherche, des réseaux de 

fentes sont intégrés dans la structure de ces antennes pour améliorer leurs performances sur 

une gamme de fréquences plus large que celle des antennes traditionnelles. 

Ce mémoire vise à examiner les techniques de conception et d'amélioration des 

antennes patchs planaires qui intègrent des réseaux de fentes dans le plan de masse, avec 

une résonance à 5 GHz afin de générer des comportements multifréquences. Deux 

géométries de fentes sont insérées : un réseau de fentes en forme de L et de L inversé, ainsi 

qu'un autre réseau de fentes en forme de 2L et de 2L inversé. Les positions et les dimensions 

des fentes sont déterminées à l'aide d'une analyse paramétrique pour atteindre les objectifs 

requis. 

Il a été observé que la configuration finale produit de très bonnes performances à 

six fréquences : 2,37 GHz, 3,11 GHz, 4,16 GHz, 5,88 GHz, 6,48 GHz et 7,82 GHz, avec 

un gain raisonnable. 

Mots clés: Antenne planaire, réseaux de fentes.  

Abstract 

          The study focuses on the design of planar patch antennas, which are low-profile 

antennas widely used in wireless communication applications due to their compactness and 

ease of fabrication. In this research, slot arrays are integrated into the structure of these 

antennas to enhance their performance over a wider frequency range than traditional 

antennas. 

This dissertation aims to examine design and improvement techniques for planar 

patch antennas that integrate slot arrays in the ground plane, with resonance at 5 GHz, in 

order to generate multifrequency behaviors. Two slot geometries are inserted: an array of L-

shaped and inverted L-shaped slots, and another array of 2L-shaped and inverted 2L-shaped 

slots. The positions and dimensions of the slots are determined using a parametric analysis 

to achieve the required objectives. 



 

X 

 

 

It has been observed that the final configuration produces very good performance at 

six frequencies: 2.37 GHz, 3.11 GHz, 4.16 GHz, 5.88 GHz, 6.48 GHz, and 7.82 GHz, with 

reasonable gain. 

Keywords: Patch antenna, slot arrays. 

                الملخص

تركز الدراسة على تصميم هوائيات الرقعة المستوية، وهي هوائيات ذات ملف منخفض تسُتخدم بشكل واسع في 

تطبيقات الاتصالات اللاسلكية نظرًا لصغر حجمها وسهولة تصنيعها. في هذا البحث، يتم دمج شبكات الشقوق في هيكل 

 .ق ترددات أوسع من الهوائيات التقليديةهذه الهوائيات لتحسين أدائها على نطا

تصميم وتحسين هوائيات الرقعة المستوية التي تدمج شبكات الشقوق إلى دراسة تقنيات هدف هذه الأطروحة ت

سلوكيات متعددة الترددات. يتم إدخال شكلين من الشقوق: شبكة  ، من أجل توليد جيجاهرتز 5 مع رنين عندية في الأرض

مقلوب. يتم  2L وحرف  2L بكة أخرى من الشقوق على شكلمقلوب، وش L وحرف L حرف من الشقوق على شكل

 .تحديد مواضع وأبعاد الشقوق باستخدام تحليل بارامتري لتحقيق الأهداف المطلوبة

 4.16جيجاهرتز،  3.11جيجاهرتز،  2.37لوحظ أن التكوين النهائي ينتج أداءً جيداً جداً عند ستة ترددات: 

 .جيجاهرتز، مع كسب معقول 7.82جيجاهرتز و  6.48جيجاهرتز،  5.88جيجاهرتز، 

 .الشقوق شبكات الرقعة، هوائي :المفتاحية الكلمات
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Introduction générale 

                                                           

           Dans un monde de plus en plus connecté, la demande en technologies de communication 

avancées ne cesse de croître. Les systèmes de communication modernes exigent des dispositifs 

capables de fonctionner sur plusieurs fréquences, tout en conservant des performances élevées 

et une compacité optimale. Dans ce contexte, les antennes jouent un rôle crucial et parmi elles, 

les antennes patchs planaires se distinguent par leur simplicité de fabrication, leur faible coût et 

leur capacité à être intégrées facilement dans divers dispositifs électroniques [1].  

           Les antennes patchs planaires sont particulièrement pour les applications de 

communication sans fil, telles que les réseaux locaux sans fil (WLAN), les communications par 

satellite, et les systèmes de communication mobile. Leur structure compacte et leur faible profil 

les rendent idéales pour des applications où l'espace est limité. Cependant, une limitation 

notable des antennes patch classiques réside dans leur bande de fréquence relativement étroite.           

           Pour pallier ce problème, l'intégration de réseaux de fentes dans la conception des 

antennes patch a émergé comme une solution efficace pour atteindre des performances 

multifréquences [2]. 

           Ce mémoire vise à explorer les principes de conception et d'optimisation des antennes 

patch planaires intégrant des réseaux de fentes. L'objectif est de développer des antennes 

capables de fonctionner efficacement sur plusieurs bandes de fréquences, répondant ainsi aux 

exigences des systèmes de communication modernes. Nous commencerons par une revue des 

concepts fondamentaux relatifs aux antennes patch et aux réseaux de fentes, avant de passer à 

la modélisation et à la simulation des configurations proposées à l'aide de logiciels de simulation 

tels que HFSS [2]. 

          Le travail présenté dans ce mémoire se divise en trois chapitres structurés de la manière 

suivante: 

          Dans le premier chapitre, une étude des antennes en général a été menée, couvrant leurs 

caractéristiques, les différents types d'antennes et les types d’alimentation utilisés. Une attention 

particulière a été accordée à l'antenne patch en général, qui s'applique à divers cas d’intégration. 

La simplicité des structures d’antenne patch permet de réduire les coûts de fabrication, ce qui 

en fait un choix idéal pour les applications nécessitant un faible coût de production. Cette  
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caractéristique fondamentale explique l’introduction et la popularité croissante des antennes 

patch dans les applications de communications mobiles. 

         Le deuxième chapitre est dédié à la présentation du logiciel HFSS (High Frequency 

Structure Simulation). Nous y décrirons de manière générale le rôle de chaque fonction 

utilisée pour réaliser nos simulations. Une attention particulière sera accordée aux étapes à 

suivre pour créer un projet, en insistant sur les procédures essentielles pour configurer et 

exécuter les simulations efficacement. 

         Le troisième chapitre est dédié à la conception et à la simulation des antennes patch.        

Notre objectif principal est de développer une antenne inset feed qui résonne à une fréquence 

de 5 GHz, puis de modifier la géométrie de l'antenne pour obtenir une antenne multifréquence. 

Ce chapitre est divisé en plusieurs sections. Tout d'abord, nous présentons les caractéristiques 

et les spécifications de l'antenne de base, en expliquant les principes de conception utilisés pour 

atteindre la résonance à 5 GHz. Ensuite, nous décrivons la technique utilisée pour obtenir une 

antenne multifréquence. Ce chapitre est structuré en trois parties distinctes: 

1.  Conception d'une antenne patch conventionnelle avec une fréquence de résonance de 5 

GHz. 

2. Amélioration des performances de cette antenne en concevant une antenne patch 

multifréquence avec l'ajout de deux fentes en forme de L (L et L inversés) dans le plan 

de masse. 

3. Pour suite de l'amélioration des performances en concevant une antenne patch 

multifréquence avec l'ajout de quatre fentes en forme de L dans le plan de masse. 

           Chaque section détaillera les étapes spécifiques et les techniques utilisées pour atteindre 

les objectifs de conception et de performance des antennes patch multifréquence et présentera 

les différents résultats obtenus. 

           Enfin, le mémoire se termine par une conclusion générale et une bibliographie.
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I.1 INTRODUCTION  

            Dans le domaine des télécommunications, les antennes jouent un rôle vital en assurant 

la transmission efficace des signaux électromagnétiques. Leur fonctionnement repose sur la 

conversion entre signaux électriques et ondes radio, permettant ainsi la communication sans 

fil sur de longues distances.  

Les antennes sont présentes dans une gamme variée d'applications, allant des réseaux 

cellulaires aux satellites en orbite, en passant par les réseaux Wi-Fi et les dispositifs IoT 

(Internet of Things). Leur conception et leurs caractéristiques influencent directement la 

qualité, la portée et la fiabilité des communications.  

En constante évolution, les antennes dans le domaine des télécommunications sont 

sujettes à des recherches et des innovations visant à améliorer les performances, réduire la 

taille et optimiser l'efficacité énergétique des systèmes de communication modernes. 

Ce chapitre sera consacré à la présentation générale des antennes ainsi que de leurs 

caractéristiques. Nous aborderons spécifiquement les antennes patch, en mettant en avant 

leurs techniques d'alimentation, leurs avantages et leurs inconvénients. Enfin, nous 

explorerons les différents domaines d'application de ces antennes. 

I.2 Généralités sur les antennes  

I.2.1 Définition d’une antenne 

La norme IEEE fournit la définition la plus précise d'une antenne. Selon cette norme, 

une antenne est un dispositif utilisé pour émettre ou recevoir des ondes radio. En termes plus 

concrets, une antenne reçoit des signaux d'une ligne de transmission, les transforme en ondes 

électromagnétiques et les diffuse dans l'espace lorsqu'elle est en mode émission. En mode 

réception, elle capte simplement les ondes électromagnétiques incidentes et les convertit en 

signaux [3]. 

I.2.2 Rôle d’une antenne  

L’antenne a plusieurs rôles dont les principaux sont les suivants :  

 Permettre une adaptation correcte entre l’équipement radioélectrique et le milieu 

de propagation.                                                                                                       

 Assurer la transmission ou la réception de l’énergie dans des directions 

privilégiées. 
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 Transmettre le plus fidèlement possible une information [4]. 

      

Figure I.1 : Un système de radio communication illustrant le rôle d’une antenne [5]. 

I.2.3 Caractéristiques d’une antenne 

          Les caractéristiques d'une antenne sont des facteurs qui auront un impact sur son 

fonctionnement et nous aideront à déterminer ses performances [6]. 

I.2.3.1 Impédance d’entrée de l’antenne [6]  

            Le rapport entre la tension incidente  𝑽𝒊 et le courant incident 𝑰𝒊 est connu sous le nom 

d’impédance à l’entrée d’une antenne : 

𝒁𝒆 =
𝑽𝒊  

𝑰𝒊
                                                               (I.1) 

𝒁𝒆 = 𝑹𝒆 + 𝒋𝑿𝒆                                                    (I.2) 

         Z=impédance d’entrée aux bornes a et b. 

         R= résistance de l’antenne aux bornes a et b. 

         X= réactance de l’antenne aux bornes a et b. 

  

Figure I.2 : Antenne en mode émetteur. 



Chapitre Ⅰ                                                                                         Généralités sur les antennes   

  

6 

 

I.2.3.2 Diagramme de rayonnement [6]  

            Un diagramme de rayonnement d'une antenne est une représentation graphique qui 

illustre la distribution de la puissance rayonnée dans l'espace par l'antenne dans différentes 

directions. Il montre comment l'énergie électromagnétique est émise ou reçue par l'antenne 

dans les différentes directions, ce qui permet d'évaluer ses performances dans un 

environnement donné. 

            On peut représenter le schéma de rayonnement de la manière suivante : 

 En décrivant la variation de la puissance par unité d’angle solide en fonction de la 

direction : 

𝒓(𝜽,𝝋) =
𝑷(𝜽,𝝋)

𝑷𝒎𝒂𝒙
                                                      (I.3) 

 En fonction du champ rayonné 𝐸(𝜃, 𝜑) (
𝑉

𝑚
) 

𝑷(𝜽,𝝋) =
𝟏

𝟐
 .

|�⃗⃗� |
𝟐

𝟏𝟐𝟎
(

𝑾

𝒎𝟐
)                                            (I.4) 

       

a – isotrope                         b -  omnidirectionnel         c - directif 

Figure I.3 :  Exemple de diagramme de rayonnement d’antenne [7]. 

   Deux plans perpendiculaires représentent le diagramme de rayonnement :  

 Le plan E est défini comme le plan qui regroupe l’axe de l’antenne et le champ 

électrique, avec une valeur de: (φ=0,0<θ<2π). 

 Le plan H est défini comme le plan qui comprend l’axe de l’antenne et le champ 

magnétique, avec : (θ =π/2, 0< φ). 
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I.2.3.3 Gain [6] 

Le gain G(𝜃, 𝜑) d'une antenne dans une direction (𝜃, 𝜑) est le rapport entre la puissance 

rayonnée dans cette direction P(𝜃, 𝜑)  et 𝑷𝑨 la puissance de antenne isotrope sans pertes. En 

général, le gain G correspond au gain maximal dans la direction de rayonnement (𝜽𝟎,𝝋𝟎) 

       G(θ,φ)=4π P(θ,φ)/𝑷𝑨⇒G=4π P(𝜽𝟎,𝝋𝟎 )/ 𝑷𝑨                              (I.5)   

          Cette caractéristique définit la capacité d'une antenne à diriger la puissance rayonnée 

dans une direction spécifique. Dans le cas d'une direction omnidirectionnelle et de pertes, le 

gain de l'antenne est de 1 ou 0 dB. Le gain maximal de l'antenne exprimé en dB est 

représenté par : 

𝐆𝐦𝐚𝐱 = 𝟏𝟎𝐥𝐨𝐠𝟏𝟎𝐆(𝛉,𝛗)                                          (I.6)                                    

I.2.3.4  Directivité  

La directivité d'une antenne est une mesure de sa capacité à concentrer l'énergie 

rayonnée dans une direction particulière par rapport à une antenne de référence idéale. Une 

directivité élevée signifie que l'antenne est plus directive, c'est-à-dire qu'elle rayonne ou capte 

davantage d'énergie dans certaines directions spécifiques, tandis qu'une directivité plus faible 

indique une répartition plus uniforme de l'énergie dans toutes les directions.  

 La directivité est définie comme le rapport entre la puissance rayonnée par unité 

d'angle solide dans une direction donnée (θ, φ) et la puissance rayonnée par unité d'angle 

solide d'une source isotrope de référence émettant la même puissance totale [6]. 

𝐃(𝛉,𝛗) = 𝟒𝛑 
𝐩(𝛉,𝛗)

𝛈𝐩𝐀
    [𝐖/𝐦𝟐]                                        (I.7) 

   𝛈 : le rendement. 

I.2.3.5 Angle d’ouverture d’une antenne  

L'angle d'ouverture d'une antenne est une mesure qui décrit la direction dans laquelle 

l'antenne peut émettre ou recevoir des signaux de manière efficace. Plus précisément, il s'agit 

de l'angle solide dans lequel l'antenne peut échanger des signaux avec un dispositif distant. 

Cet angle est souvent mesuré par rapport à l'axe principal de l'antenne. Plus l'angle d'ouverture 

est large, plus l'antenne est capable de couvrir une zone étendue. L'angle d'ouverture est un 

concept important dans la conception et l'utilisation des antennes, en particulier dans les 

domaines des télécommunications et de la radiodiffusion [6]. 
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On peut calculer l’angle d’ouverture comme suite : 

   𝛉 =
𝐏𝐦𝐚𝐱

𝟐
                                                                (I.8) 

 

 Figure I.4 : Angle d’ouverture d’une antenne. 

I.2.3.6 Rendement  

Le rendement d'une antenne mesure son efficacité à convertir la puissance électrique 

reçue ou émise en ondes électromagnétiques. Un rendement élevé indique que la majorité de 

la puissance est utilisée pour la communication, tandis qu'un rendement faible signifie des 

pertes importantes. Ces pertes peuvent être causées par divers facteurs tels que les pertes 

ohmiques, les réflexions ou les pertes diélectriques. Un bon rendement est crucial pour une 

communication sans fil fiable et efficace. 

Le rendement 𝛈 d'une antenne est défini comme le rapport entre la puissance totale 

émise par l'antenne et la puissance fournie à l'antenne est défini comme [6] : 

  𝛈 =  
𝑷𝒓

𝑷𝒂
                                                                 (I.9)  

I.2.3.7   Polarisation  

  La polarisation d’une antenne consiste à orienter les ondes planes produites par cette 

antenne dans une direction précise. La polarisation d’une onde plane est généralement définie 

comme la variation du champ électrique E par rapport à un point d’observation donné dans le 

temps. Trois catégories de polarisation existent : la polarisation linéaire, la polarisation 

circulaire et la polarisation elliptique (voir Figure I.5). 
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Figure I.5 : Types de polarisation [6]. 

I.2.3.8 Coefficient de réflexion 𝐒𝟏𝟏ou Γ  

Le coefficient de réflexion S11 d'une antenne est une mesure qui décrit la proportion 

d'énergie réfléchie par l'antenne par rapport à l'énergie incidente. Il indique à quel point 

l'antenne est adaptée à son environnement et à la transmission de signaux. Un S11 proche de 

zéro indique une bonne adaptation, ce qui signifie que la plupart de l'énergie est transmise à 

l'antenne et peu est réfléchie. Un S11 élevé indique une mauvaise adaptation, avec une quantité 

significative d'énergie réfléchie. Ce coefficient est crucial dans la conception et le réglage des 

antennes pour maximiser leur efficacité de transmission.  

On considère qu’une antenne est parfaitement adaptée lorsque son impédance d’entrée 

(𝒁𝒆) est égale à l’impédance de la ligne d’alimentation (𝒁𝒄), sinon on observe un coefficient 

de réflexion 𝑺𝟏𝟏 ou  Γ 

          𝜞 = 𝑺𝟏𝟏 =
𝐳𝐞−𝐙𝐜

𝐳𝐞+𝐙𝐜

=
𝐨𝐧𝐝𝐞 𝐫𝐞𝐟𝐥𝐞𝐜𝐡𝐢𝐞

𝐨𝐧𝐝𝐞 𝐢𝐧𝐜𝐢𝐝𝐞𝐧𝐭𝐞
                                      (I.10)                                                                       

       Couramment exprimé en dB 

           𝑺𝟏𝟏 = 𝟐𝟎 𝒍𝒐𝒈𝟏𝟎 (𝑺𝟏𝟏)                                                        (I.11) 

𝒁𝒆: Impédance d’entrée de l’antenne (𝒁𝒆= R+ jX). 

   𝒁𝒄: Impédance caractéristique de la ligne.  

 On dit que l’antenne est adaptée si 𝑺𝟏𝟏 = 𝟎  donc 𝒁𝒆 = 𝒁𝒄. 

  L’adaptation de l’antenne est parfois définie par le rapport d’onde stationnaire (ROS) 

ou (Voltage Standing Wave Ratio : VSWR), qui est généralement représenté comme suit : 

𝐑𝐎𝐒 =  
𝟏+|𝚪|

𝟏−|𝚪|
                                                                  (I.12) 
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Ce rapport peut varier de 1 à l’infini. Dans la réalité, une adaptation satisfaisante est 

obtenue lorsque le taux d’onde stationnaire est inférieur à 2 [6]. 

I.2.3.9  Bande passante  

La bande passante d'une antenne représente la gamme de fréquences sur laquelle elle 

peut fonctionner efficacement pour émettre ou recevoir des signaux. Elle est définie par les 

fréquences où les performances de l'antenne restent acceptables selon des critères prédéfinis 

tels que le gain, le coefficient de réflexion ou la directivité. Une large bande passante permet 

à l'antenne de couvrir un large éventail de fréquences, tandis qu'une bande passante étroite la 

limite à des fréquences spécifiques. La bande passante est essentielle dans la conception et 

l'utilisation des antennes, car elle détermine leur flexibilité et leur efficacité dans divers 

environnements et applications de communication.  

Le coefficient de réflexion peut également être utilisé pour déterminer la bande 

passante, à condition que le diagramme de rayonnement ne soit pas modifié dans cette bande. 

Il est généralement utilisé lorsque le coefficient de réflexion en dB est inférieur à -10 dB, 

c’est-à-dire lorsque 90 % de la puissance fournie à l’antenne est convertie et le reste est 

réfléchi [6]. 

       

Figure I.6: Bande passante et coefficient de réflexion [6]. 

 On exprime souvent la bande passante, LB en un pourcentage exprimant le rapport de 

la bande à la fréquence centrale 𝑓0 : 

𝑳𝑩 =
𝒇𝟐−𝒇𝟏

𝒇𝟎
                                                            (I.13) 
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I.3 Différente types d’antenne 

          Différents types d’antennes sont disponibles selon la géométrie, le gain, la forme de 

faisceau et la bande passante. Parmi ces dernières, on peut mentionner quelques exemples :  

I.3.1 Antenne dipolaire  

          La structure d'une antenne dipolaire est formée de deux fils alignés, très courts, reliés 

chacun à deux fils parallèles et très proches, créant ainsi une ligne bifilaire (voir Figure I.7). 

          En émission, cette ligne est connectée à un générateur alternatif, caractérisé par sa 

fréquence et son impédance interne. En réception, la ligne bifilaire est connectée à un 

récepteur.  

          Les courants dans la ligne bifilaire circulent dans des sens opposés, contrairement au 

dipôle où ils circulent dans la même direction. Dans la ligne bifilaire, l'effet de ces deux 

courants est annulé. Les courants variables dans la même direction sont responsables de la 

diffusion et de la création de l'onde électromagnétique dans l'espace. Comme le dipôle est 

symétrique, le rayonnement se produit autour de l'axe matérialisé par le fil et il se trouve dans 

un plan isotrope. 

 

Figure I.7: Antenne dipolaire [8].  

I.3.2 Antenne monopôle 

            Une antenne monopôle, également connue sous le nom d'antenne à un quart d'onde 

est composée d'un élément vertical conducteur et d'un plan de masse. Elle est utilisée dans 

diverses applications de communication sans fil telles que les téléphones portables et les 

réseaux Wi-Fi. Cette antenne est pratique pour les installations sur les toits ou les tours en 

raison de sa polarisation verticale et de sa directivité relativement faible réseaux Wi-Fi. 
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Figure I.8: Antenne monopole [8]. 

I.3.3 Antenne cornet 

             L'antenne cornet est un dispositif utilisé en transmission et réception d'ondes 

électromagnétiques. Sa structure ressemble à un cornet renversé d'où son nom. Elle est conçue 

pour transformer l'énergie électromagnétique guidée dans un guide d'ondes en énergie 

rayonnée dans l'espace libre. L'antenne cornet est caractérisée par un rayonnement directif, 

généralement dans l'axe principal du cornet. Elle est largement utilisée dans divers domaines, 

tels que les télécommunications, le radar, ou encore la radioastronomie, en raison de sa 

capacité à fournir une directivité élevée et un bon rendement.   

                  

Figure I.9: Antenne cornet [8].  

I.3.4 Antenne parabolique 

             Les antennes paraboliques sont des dispositifs utilisés pour transmettre et recevoir des 

ondes électromagnétiques, principalement dans les télécommunications. Elles se composent 

d'un réflecteur parabolique et d'un élément actif placé à son foyer, tel qu'un dipôle ou un 

alimentateur. Le réflecteur parabolique concentre les ondes vers ou depuis l'élément actif, 

augmentant ainsi la puissance du signal dans une direction spécifique. Ces antennes sont 
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largement utilisées dans les réseaux sans fil, les liaisons satellite et d'autres applications 

nécessitant une communication à longue distance et à haute directivité [8]. 

               

Figure I.10 : Antenne à réflecteur parabolique [8]. 

I.3.5 Antenne imprimée  

  Les antennes patchs ont été introduites dans les années 50, mais leur développement 

significatif a eu lieu dans les années 70. Aussi appelée antenne planaire, la structure d'une 

antenne patch consiste en une surface conductrice, souvent carrée, séparée d'un plan réflecteur 

conducteur par une lame diélectrique. Cette configuration la rend semblable à un circuit 

imprimé double face, ce qui facilite sa fabrication à grande échelle. 

             Les antennes patch peuvent être utilisées individuellement ou comme partie d'un 

réseau. Elles sont couramment employées pour réduire l'encombrement des antennes, en 

particulier leur hauteur au-dessus d'un plan de masse. Les antennes en réseaux planaires sont 

largement utilisées dans les réseaux Wi-Fi et dans de nombreuses applications de 

transmissions professionnelles [5][8]. 

   

Figure I.11 : Antennes Imprimée. 



Chapitre Ⅰ                                                                                         Généralités sur les antennes   

  

14 

 

   L’antenne imprimée se compose de : 

Le plan de masse (ground plane) : est une surface conductrice en cuivre qui recouvre 

la face inférieure du substrat. Sa fonction est de refléter les ondes électromagnétiques vers 

l'élément rayonnant. 

Le substrat diélectrique (dielectric substrate) : composé d’un matériau isolant, 

d'épaisseur généralement faible par rapport à la longueur d'onde et avec une permittivité 

relative comprise généralement entre (2,2<𝜀𝑟<12). Il est utilisé pour soutenir l'élément 

rayonnant et peut également jouer un rôle dans le contrôle de l'impédance. 

L'élément rayonnant (patch) : est une composante métallique dont la forme et la 

taille peuvent varier en fonction de l'application avec une géométrie variable (circulaire, 

rectangulaire, triangulaire, etc.). Il est nécessaire de le connecter au reste du circuit à l’aide 

d’une ligne de transmission (micro ruban) spécialement conçue pour être adaptée à l’antenne 

et au reste du circuit, afin d’éviter toute réflexion. 

               

Figure I.12 : Configuration de base d’une antenne patch [9]. 

I.3.5.1 Différentes formes d'une antenne patch  

            Le patch et le plan de masse sont généralement en cuivre. Le patch peut prendre 

différentes formes, telles que le rectangle, l’ellipse, le cercle, le triangle, l’anneau, etc. 

     
Figure I.13 : Différentes formes du patch [10]. 
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          Les caractéristiques désirées, telles que la polarisation, le gain, la directivité, la largeur 

de bande passante, etc., déterminent la forme du patch. Ils sont généralement définis par les 

modes de fonctionnement excités qui sont influencés par la forme et la taille du patch, le 

substrat diélectrique et son épaisseur ainsi que le dispositif d’alimentation [10]. 

I.3.5.2 Paramètres géométriques de l’antenne patch  

          Selon Balanis [3], la fréquence de résonance pour une antenne patch est donnée par: 

𝒇𝒓 =
𝒄

𝟐𝑳𝒆𝒇𝒇√𝜺𝒓𝒆𝒇𝒇  
                                                             (I.14) 

c : la vitesse de la lumière (c = 3*108m/s) 

Leff : la longueur efficace. 

𝛆𝐫𝐞𝐟𝐟: permittivité effective.  

          L’impédance d’entrée est donnée par l’équation :  

𝐙𝐢𝐧 = 𝐙𝟎𝐜𝐨𝐬𝟐 (
𝛑

𝐋
𝐲𝟎)                                                     (I.15) 

           𝐙𝟎: l’impédance caractéristiques. 

           𝐲𝟎 : position d’alimentation. 

           La procédure d’une conception pratique d’une antenne patch suppose la connaissance 

de la constante diélectrique du substrat εr, de la fréquence de résonance fr et de la hauteur du 

substrat h, la conception suit donc les étapes suivantes :  

 Spécification de fr , εr et h.   

 Déterminer la largeur w et la longueur L du patch.  

           Pour un rayonnement efficace, la largeur pratique du patch est calculée comme suit :  

𝐰 = 
𝐜

𝟐𝐟𝐫
√

𝟐

𝛆𝐫+𝟏
                                                             (I.16) 

        Ensuite, nous pouvons calculer εreff . L’expression de εreff est donnée par Balanis [3] 

comme suit:      

 𝛆𝐫𝐞𝐟𝐟 = (
𝛆𝐫+𝟏

𝟐
) + (

𝛆𝐫−𝟏

𝟐
) (𝟏 + 𝟏𝟐 

𝐡

𝐰
)

−𝟏

𝟐
   (I.18) 
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       Maintenant, calculons la longueur efficace Leff et l’extension de longueur ΔL du patch 

avec les équations suivantes :   

𝐋𝐞𝐟𝐟 = 
𝐜

𝟐𝐟𝐫√𝛆𝐞𝐟𝐟
                                                              (I.19 

∆𝐋  défini par l'équation suivante : 

∆𝑳 = 𝟎. 𝟒𝟏𝟐𝒉 [
(𝛆𝐫𝐞𝐟𝐟+𝟎.𝟑)(

𝒘

𝒉
+𝟎.𝟐𝟔𝟒)

(𝜺𝒓𝒆𝒇𝒇−𝟎.𝟐𝟓𝟖)(
𝒘

𝒉
+𝟎.𝟖𝟏𝟑)

]                      (I.20)  

            Finalement, nous pouvons calculer la longueur réelle de l'élément de rayonnement 

rectangulaire avec l'équation suivante :                                             

                                                 𝐋 = 𝑳𝒆𝒇𝒇 − 𝟐∆𝑳                                                         (I.21) 

 

Figure I.14 : Antenne patch avec le point d'insertion de couplage. 

I.4 Techniques d'alimentations  

La gestion de l'alimentation des antennes planaires joue un rôle crucial dans le 

processus de conception. Ainsi, diverses méthodes ont été prises en compte dans cette optique. 

On peut les répartir en deux catégories principales : 

  • Les systèmes d'alimentation par contact (sonde ou ligne micro ruban). 

 • Les systèmes d'alimentation par proximité (couplage électromagnétique par ligne ou fente). 

I.4.1 Alimentation directe par une ligne micro ruban 

            Dans cette alimentation, une ligne micro ruban est connectée directement au bord du 

patch voir (Figure I.15), Cette ligne est plus petite concernant la largeur par rapport au patch. 
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Figure I.15 : Alimentation par une ligne micro ruban [11]. 

I.4.2 Alimentation par sonde coaxial 

           L’alimentation coaxiale est très utilisée dans les antennes micro-ondes à cause de sa 

simplicité de mettre en œuvre et sa facilité d’adaptation d’impédance. Le câble coaxial se 

compose de deux conducteurs (externe et interne). Le conducteur externe est relié au plan de 

masse tandis que le conducteur intérieur est relié au patch rayonnant. Mais ce type 

d’alimentation présente une bande passante étroite et une grande difficulté de la modéliser, 

surtout pour des substrats épais. La structure est montrée sur (Figure I.16).  

 

 

Figure I.16 : Alimentation du patch rectangulaire avec un câble coaxial [11]. 
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I.4.3 Alimentation couplée par ouverture 

           Dans ce type d’alimentation, le patch de rayonnement et la ligne d’alimentation sont 

séparés en plan de masse comme indique sur (Figure I.17). Une ouverture ou une fente dans 

le plan de masse permet de relier le patch à la ligne d'alimentation. 

 

 

Figure I.17 :  Alimentation couplée par ouverture [11]. 
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I.4.4 Alimentation couplée par proximité 

             Ce type d’alimentation est illustré sur (Figure I.18). Deux substrats diélectriques sont 

employés de telle manière que la ligne d’alimentation soit insérée entre eux et que le patch soit 

sur le substrat supérieur. Il offre la meilleure bande passante, est facile à modéliser et présente 

un faible rayonnement parasite. Le principal inconvénient de ce type d'alimentation est qu'il est 

difficile à mettre en œuvre. 

 

     

Figure I.18 :  Alimentation couplée par proximité [11]. 
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I.4.5 Avantages et inconvénients de différentes techniques d’alimentations 

Méthodes  Avantages  Inconvénients  

Alimentation 

avec contact  

 

Sonde  

Coaxiale  

-Pas de pertes par rayonnement de 

ligne. 

-Sélection possible d’un mode 

privilégié. 

-Obtention d’une impédance 

d’entrée adéquate par 

positionnement de la sonde. 

-Prédiction aisée de l’impédance 

d’entrée pour des substrats faible 

hauteur.  

-Technique de perçage simple 

jusqu’à 10 GHz.  

-l’augmentation du rayonnement 

parasite.  

-Partie selfique ramenée par  

l’âme du connecteur à prendre en 

compte.  

-Technique de perçage et de 

soudure plus délicate en 

millimétrique.  

-Difficile à exciter chaque  

élément d’un réseau seul.  

 

Ligne micro 

ruban  

-Procédé technologique plus 

simple par gravure sur la même 

face de l’antenne et du circuit 

d’alimentation. 

-adaptation de l’aérien possible par 

contact pénétrant.  

-Rayonnement parasite de la 

discontinuité ligne-aérien.  

-Rayonnement parasite possible 

du circuit de distribution en 

millimétrique.  

-Structure figée après gravure.  

Alimentation 

Sans contact  

Par 

proximité  

-Dessin du circuit d’alimentation 

modifiable par rapport aux 

aériens.  

-Bande passante plus large par 

augmentation de la hauteur.  

-Deux couches de substrat 

Requises.  

-Difficulté pour l’intégration de 

dispositifs actifs et pour la 

dissipation de chaleur.  

 

Couplage 

par 

ouverture 

 

-Réalisation du circuit de 

distribution et de l’aérien  

Indépendantes. 

-Séparation électromagnétique 

des deux couches.  

-Possibilité d’élargir la bande 

passante en associant la résonance 

de l’élément rayonnant à celle de 

la fente . 

-Technologie plus couteuse et 

complexe (positionnement des 

deux couches, quatre faces de 

métallisation)  

- Intégration sur un support 

mécanique nécessitant des 

précautions.  

-Rayonnement arrière parasite 

de la fente lorsque celle-ci 

résonne au voisinage de 

l’élément . 

Tableau I.1: Avantages et inconvénients de différentes techniques d’alimentations [4][12]. 
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I.4.6 Comparaison entre les différentes méthodes d'alimentation 

  Caractéristiques  Alimentation 

par  micro 

ruban  

Alimentation 

coaxiale  

Alimentation 

par ouverture  

Alimentation 

par proximité  

Rayonnement  

parasite  

plus  plus  Moins  Minimum  

Fiabilité  Meilleur  Pauvre  Bon  Bon  

Facilité de 

fabrication  

Facile  Soudure et 

Forage requis  

Alignement 

requis  

Alignement 

requis  

    Bande passante  2 à 5%  2 à 5%  2 à 5%  13%  

Tableau I.2 : Comparaison entre les différentes méthodes d'alimentation [13]. 

I.5 Techniques pour améliorer les antennes patch pour un 

comportement multifréquence 

             Pour améliorer une antenne patch afin d'obtenir un comportement multifréquence, 

plusieurs techniques peuvent être utilisées. Parmi celles-ci, l'antenne à réseau de fentes est une 

méthode spécifique. Voici les techniques principales, y compris l'antenne à réseau de fentes : 

I.5.1  Antennes fractales 

             Les antennes fractales exploitent des géométries fractales, caractérisées par des motifs 

auto-similaires répétés à différentes échelles, pour créer des structures capables de résonner 

naturellement à de multiples fréquences. Cette propriété permet aux antennes fractales d'offrir 

un comportement multifréquence, car chaque résonance correspond à une échelle de la 

structure fractale. En intégrant ces géométries complexes, les antennes peuvent ainsi 

fonctionner efficacement sur plusieurs bandes de fréquences avec une seule et même structure 

physique, ce qui les rend particulièrement adaptées pour des applications nécessitant une 

compacité et une polyvalence en termes de fréquence, telles que les communications sans fil, 

les systèmes de surveillance et les dispositifs portables [14]. 
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Figure I.19 : Différents types d’antennes fractales [15]. 

I.5.2 Utilisation de substrats à permittivité variable 

             L'utilisation de substrats à permittivité variable permet de contrôler et d'ajuster les 

fréquences de résonance d'une antenne. La permittivité, qui mesure la capacité d'un matériau 

à stocker de l'énergie électrique, influence directement la vitesse de propagation des ondes 

électromagnétiques dans le substrat. En choisissant des substrats avec différentes permittivités 

ou en utilisant des matériaux dont la permittivité peut être modifiée (par exemple, par 

l'application d'un champ électrique ou thermique), il est possible de moduler les 

caractéristiques de résonance de l'antenne. Cela offre une flexibilité considérable dans la 

conception des antennes, permettant d'optimiser leur performance pour des applications 

spécifiques, telles que les communications adaptatives, les dispositifs reconfigurables et les 

systèmes de détection avancés, en ajustant précisément les fréquences de fonctionnement en 

fonction des besoins opérationnels [16]. 

 

Figure I.20 : Échantillon fabriqué d'antenne utilisant des substrats à permittivité variable.   
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I.5.3 Antenne à Réseaux de Fentes 

            Les antennes à réseaux de fentes (ou slot array antennas) utilisent des fentes 

découpées dans un patch métallique ou dans le plan de masse pour créer des résonances 

supplémentaires à différentes fréquences. Fonctionnant sur le principe où une antenne patch 

traditionnelle est composée d'un patch conducteur au-dessus d'un plan de masse avec un 

substrat diélectrique entre les deux, les fentes ajoutées modifient la distribution des courants 

et des champs électromagnétiques en créant des chemins supplémentaires pour les courants 

de surface. Chaque fente agit comme un résonateur individuel à une fréquence spécifique, 

perturbant la distribution uniforme du courant et générant ainsi des modes de résonance 

supplémentaires. Cette configuration permet à l'antenne de résonner à plusieurs fréquences 

(multibande) ou d'avoir une bande passante plus large (large bande). Les antennes à réseaux 

de fentes sont idéales pour des applications nécessitant une compacité et une capacité 

multibande, telles que les communications sans fil, les radars et les systèmes de détection. En 

conclusion, intégrer un réseau de fentes dans une antenne patch ou son plan de masse permet 

d'améliorer les performances de l'antenne en termes de multibande ou de large bande, ce qui 

est précieux pour diverses applications technologiques [17]. 

 

Figure I.21 : Antennes à réseaux de fente pour un fonctionnement multibande. 
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I.6 Avantages et inconvénients des antennes patch 

            Les antennes imprimées comportent plusieurs avantages, parmi lesquels les plus 

importants sont les suivants:  

 Poids léger, réduction de l’encombrement, possibilité de configurations conformes.  

 Faible coût de fabrication, possibilité de production en masse  

 Polarisation linéaire et circulaire dans le domaine des télécommunications.  

 Antennes avec plusieurs bandes, plusieurs polarisations envisageables. 

 Compatibilité avec les circuits hybrides et MMIC (Microwave Monolithic Integrated 

Circuit).  

 Réseaux d’alimentation et d’adaptation fabriqués simultanément avec l’antenne.  

 Simplicité de leurs structures. 

 Faible volume. 

 Faible épaisseur. 

      Les antennes imprimées présentent un certain nombre d’inconvénients:  

 Bande passante étroite, souvent associée avec les problèmes de tolérance (géométriques 

et physiques). 

 Généralement faible gain. 

 Problèmes de fabrication en cas de motifs imprimés de petite taille. 

 La majorité des antennes ne diffusent que dans le demi-plan. 

 Ne supportent que des puissances faibles (100 mW). 

 Réduction des ondes de rayonnement [6]. 

I.7 Applications 

 Les antennes sont employées dans diverses plage de longueur d'onde, pour de 

nombreuses applications, dont nous citerons quelques exemples : 

 La radiodiffusion à modulation d'amplitude, les signaux horaires et les liaisons avec 

les sous-marins utilisent des ondes kilométriques (30 à 300 kHz) et hectométriques 

(300 à 30000 kHz). 

 Emission d'ondes décamétriques (3 à 30MHz) pour les connexions à l'échelle 

internationale ou maritime.  

 La radiodiffusion à modulation de fréquence, la télévision et les communications et les 

radionavigations aéronautiques utilisent des ondes métriques (30 à 300MHz). 
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 La télévision, le radar et les connexions avec les appareils mobiles utilisent des ondes 

décimétriques (300 à 3000MHz). 

 Liaisons terrestres par faisceaux hertziens et liaisons spatiales par ondes 

centimétriques (3 à 30GHz) utilisant des ondes centimétriques [7]. 

I.8 Conclusion   

            Ce chapitre nous a offert une plongée détaillée dans le monde des antennes, des 

dispositifs essentiels dans le domaine de la radiocommunication. Nous avons exploré leur 

définition, leur rôle crucial dans la transmission et la réception des ondes électromagnétiques 

ainsi que leurs caractéristiques fondamentales telles que l'impédance, le diagramme de 

rayonnement, le gain et la directivité. En comprenant les différents types d'antennes, des 

dipôles aux antennes imprimées, nous avons saisi la diversité des solutions disponibles pour 

répondre aux besoins variés des applications de communication. De plus, l'importance des 

paramètres géométriques dans la conception des antennes patch a été mise en évidence, 

soulignant l'aspect pratique et concret de leur mise en œuvre. Enfin, nous avons examiné les 

techniques d'alimentation, chacune avec ses avantages et ses inconvénients, illustrant la 

complexité et la richesse des décisions de conception dans ce domaine.  

   Dans le prochain chapitre, nous fournirons une description du logiciel HFSS ainsi 

que de son environnement de travail, où nous mettrons en œuvre les différentes structures 

étudiées. 
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II.1   Introduction  

          HFSS est un outil de simulation électromagnétique et d'étude des circuits passifs ainsi 

que des structures en trois dimensions. Il facilite l'observation et l'analyse des différentes 

caractéristiques électromagnétiques de la structure, telles que les propriétés de rayonnement 

et de dispersion. Chaque étape du processus de modélisation requiert une compréhension 

approfondie afin d'obtenir des résultats fiables.  

          L'objectif de ce chapitre est de présenter le logiciel HFSS (High Frequency Structure 

Simulator), ses fonctionnalités et de fournir une vue d'ensemble du rôle de chaque fonction 

que nous utiliserons pour effectuer nos simulations [18]. 

Ⅱ.2   Présentation du logiciel Ansoft HFSS 

           HFSS (High Frequency Structure Simulation) est un logiciel commercial développé 

par Ansoft Corporation permettant le calcul des champs électromagnétiques dans le domaine 

fréquentiel en résolvant localement les équations de Maxwell. Ainsi, les propriétés du 

matériau, les dimensions, l'épaisseur, entre autres, doivent être spécifiées, de même que les 

sources électromagnétiques [18].  

Pendant la simulation, il est possible de configurer le système et de modifier ses 

paramètres. HFSS offre l'avantage de pouvoir fournir directement les paramètres X, Y, Z en 

fonction de la fréquence. Les étapes principales d'un "Design" HFSS sont représentées dans 

l'organigramme ci-dessous : 
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Figure II.1: Organigramme des différentes étapes d’un design HFSS [18]. 

II.3   Avantages et Inconvénients du HFSS 

              HFSS offre plusieurs avantages significatifs, mais il présente également quelques 

inconvénients. 

II.3.1 Avantages 

 Précision: HFSS est reconnu pour sa précision dans la modélisation des champs 

électromagnétiques, en particulier dans les structures complexes et à haute fréquence. 

 Large gamme de fréquence: Il est capable de gérer une large gamme de fréquences, 

des fréquences radio aux micro-ondes, ce qui le rend polyvalent pour diverses 

applications. 

 Interface conviviale: Son interface utilisateur est conviviale et offre une variété 

d'outils pour la modélisation, la simulation et l'analyse des structures 

électromagnétiques. 
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 Paramètres X,Y,Z: HFSS peut directement fournir les paramètres X, Y, Z en 

fonction de la fréquence, ce qui simplifie l'analyse des performances des dispositifs 

 Possibilité de modification en cours de simulation: Il permet de configurer et de 

modifier les paramètres du système pendant la simulation, offrant ainsi une grande 

flexibilité dans le processus de conception. 

II.3.2 Inconvénients  

 Coût: HFSS est un logiciel commercial et peut être assez coûteux, ce qui peut limiter 

son accessibilité pour les petites entreprises ou les individus. 

 Exigences en matière de ressources informatiques: Les simulations HFSS peuvent 

nécessiter des ressources informatiques importantes en raison de la complexité des 

modèles et de la haute précision requise, ce qui peut entraîner des temps de calcul 

longs sur des systèmes moins puissants. 

  Courbe d'apprentissage: En raison de sa complexité et de sa richesse en 

fonctionnalités, HFSS peut avoir une courbe d'apprentissage abrupte pour les nouveaux 

utilisateurs, nécessitant une formation approfondie pour une utilisation efficace. 

 Limitations de la version: Certaines versions de HFSS peuvent avoir des limitations 

en termes de nombre de nœuds, de taille de modèle ou d'autres fonctionnalités, ce qui 

peut restreindre la modélisation de certaines structures complexes [18]. 

II.4   Comment commencer HFSS 

          Il est recommandé d’installer HFSS sur l’ordinateur sur lequel vous travaillez. Il est 

prévu que l’ordinateur de bureau présente une icône de HFSS (  ) que vous pouvez 

double-cliquer pour lancer HFSS [18]. 

II.5   Comment ouvrir un nouveau projet  

         Lorsque vous débutez HFSS v 19.20, un projet est indiqué dans l’arbre de projet dans 

la fenêtre de Project Manager et est initialement nommé project1. Le nom de projet est utilisé 

pour stocker des définitions de projet, comme la tâche matérielle, les états de frontière et les 

ports d’excitation. 

II.6   Sauvegarder le projet  

       Sur le menu fichier, clique Save As, employer le navigateur de dossier pour localiser le 

dossier dans lequel vous voulez sauvegarder le projet comme C:\Ansoft\HFSS19\Projects, 



Chapitre Ⅱ                                                                                                         Présentation du logiciel HFSS 

  

30 

 

et double-cliquer le nom de dossier, puis cliquer Save.  

II.7   Description générale des outils HFSS  

La fenêtre d'Ansoft HFSS a plusieurs panneaux facultatifs : 

 

Figure II.2 : Les outils de HFSS. 

 Barre des outils : Elle englobe tous les outils pour créer un model : 

• Rotation et zoom du model : 

                 

• Type du matériau utilisé : 

                 

• Le plan dans lequel on dessine l’objet  

                   
• Raccourci des modèles du carré jusqu’au cône :  

                   
• Sélectionner une face :  
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 La fenêtre de 3D Modeler:   contient le modèle et son arbre pour la conception. 

 Gestionnaire de projet arborescent (Manager des projets) Contient un arbre de 

conception qui énumère la structure du projet. 

           

      

Figure II.3 : Manager des projets. 

 La fenêtre de Propretés: nous permet d’attribuer le nom, le matériau, la couleur…etc.  

            

Figure II.4 : Fenêtre des propriétés. 
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Commandes : on trouve la position et les paramètres (hauteur, largeur) du model, on   peut les 

modifiés à n’importe quel moment durant le travail.  

      

Figure II.5 : Les paramètres (hauteur, largeur) du model. 

 Le Message Manager: permet d'afficher tous les erreurs avant de commencer la 

simulation.  

 La fenêtre de Progress: affiche les progressions de la solution.  

 Barre des menus : Elle contient toutes les options d’HFSS notamment : HFSS>>Edit  

Arrange : 

Move : translater un élément de la structure le long d’un vecteur.  

Rotate : déplacer un élément de la structure par un angle.  

Mirror : faire translater un objet choisi autour d'un plan spécifié.  

Offset: Effectue une échelle uniforme en x, y et z. 

Duplicate : 

Along lines : Créer des copies multiples d’un objet le long d'un vecteur.  

           Around axis: Créer des copies multiples d’un objet en rotation par un angle fixe 

autour de x, y ou z.  

Mirror : Fixer l’image d’un objet autour d'un plan spécifié et créer son double. 

Draw : 

          Regroupe tous les modèles, rectangle, ellipse, cercle, boite …. 
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     HFSS : contient les fonctionnalités principales : 

 Solution Type (type de la solution):  

 Modal : Permet de calculer S11 d'une structure en haute fréquence en fonction 

des ondes incidentes et réfléchies [19].  

 Terminal : nous permet de calculer les paramètres S de mode des structures 

passives haute fréquence tel que les micro rubans, les guides d'ondes et les lignes de 

transmission excitées par une source [19].  

 Eigenmode : Permet de calculer la fréquence de résonance de la structure et les 

champs à ces fréquences [19].  

       

Figure II.6 : Types des solutions. 

 Validate :  (compiler le projet ) si tout est bon la fenêtre ci-dessous 

apparait :  

 

Figure II.7 : Compiler le projet. 
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Pour voir s’il y a des erreurs ou des warnings veuillez consultez le message manager qui 

se trouve en bas de la fenêtre.  

Analyze all :     ça prendra de 5-20min pour faire l’analyse ça dépendra de votre 

machine.  

 Une barre de progression va paraitre en vert à la fin de l’analyse vous aurez ce message :  

             

 Boundaries (conditions aux limites) 

      

Figure II.8 : Création des conditions aux limites (boundary). 

 Perfect E : aussi connu sous le nom de conducteur idéal. Le champ électrique de ce 

type de limite est perpendiculaire à la surface. Deux caractéristiques définissent 

également un conducteur automatiquement parfait. 

o Chaque surface de l’objet touchant le fond est automatiquement identifiée comme une 

limite parfaitement conductrice et attribuée le nom de condition aux limites 

extérieures. 

o Chaque objet attribué par un dispositif PEC (Conducteur électrique parfait) est 

automatiquement assigné à la condition électriquement parfaite. 

 Perfect H: est un conducteur magnétiquement parfait, il est tangentiel à la surface du 

champ E.  
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 Finite Conductivity: également connue sous le nom de limite de conductivité finie, 

vous permet de définir la surface d’un objet comme un imparfait conducteur. 

 Impedance : surface résistive qui calcule le comportement des champs et des pertes en 

utilisant des formules analytiques(Rs+jXs). Avec Rs : résistance, Xs : réactance.  

 Layered Impedance : il est possible de représenter plusieurs couches minces dans une 

structure comme une surface d’impédance.   

 Lumped RLC : une combinaison en parallèle des résistances localisées, inductance, et 

/ou de la surface du condensateur, la simulation est similaire à celle d’une impédance.  

 Radiation : également connue sous le nom de frontières absorbantes, vous donne la 

possibilité de représenter une surface électriquement ouverte : les ondes peuvent alors 

s’échapper de la structure et s'arrêter à la limite du rayonnement [19]. 

 Excitations  

Pour le type de solution "Driven Model" nous avons les types d’excitations suivantes : 

 Wave Port : Représente la surface par laquelle un signal entre ou sort de 

la géométrie.   

 Onde Incidente : Représente la propagation d'une onde incidente sur la 

géométrie.   

 Lumped Port : Représente une surface interne par laquelle un signal   

entre ou sort de la géométrie.   

 Incident Wave : Représente un champ électrique constant à travers les 

points d’une alimentation.   

 Voltage Source : Représente un courant électrique constant à travers les 

points d’une alimentation.   

 Current : Représente un courant électrique constant à travers des points 

d’excitations. 

 Magnetic Bias : Utilisé pour définir le champ intérieur net qui influe sur 

un objet de matériau ferromagnétique en 3D.  
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Figure II.9 : Types d'excitations. 

 Analyze Setup : les conditions d’analyse notamment la fréquence et son intervalle 

d’utilisation.  

 

Figure II.10 : Analyze Setup. 
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 Add Solution Setup  

           

Figure II.11 : Solution Setup. 

II.8   Etapes de simulation par HFSS  

  En effet, afin de simuler une antenne patch en utilisant le simulateur HFSS, il faut 

suivre plusieurs étapes. Voici une synthèse de ces phases : 

1. Schématiser la structure réelle de la structure : dimensions géométriques des 

différents objets.  

2. Spécification des matériaux pour chaque objet : choix du matériau, constantes 

diélectriques, conductivité des matériaux ...  

3.  Identification des sources et (ou) ports d’entrée/sortie : Manière d’exciter la 

structure, consiste à injecter la puissance sous forme d’onde électromagnétique à 

travers la porte d’alimentation déjà définie. 

4. Spécification des conditions aux limites : La résolution des équations d’ondes dans 

une structure quelconque exige la spécification des conditions aux frontières. En 

effet, le comportement des champs électromagnétiques dans le milieu en question 

dépend étroitement des frontières de la structure utilisée. Pour les types de frontières: 

CCE, CCM, rayonnantes.  
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5. Configuration des paramètres de simulation : Fréquence(s) de maillage, paramètres 

de convergence.  

6. Analyse des solutions à un ou plusieurs fréquences : Après avoir vérifié la 

conformité de la structure aux exigences du HFSS, les conditions aux frontières et 

l’excitation, la simulation sera prête à être lancée. La durée de cette simulation 

dépend essentiellement de : 

a La vitesse du calculateur (ordinateur) utilisé.  

b La complexité de la structure (volume, dimensions etc.)  

c La bande de fréquence de l’analyse. 

7. Visualisation des résultats : Le diagramme de rayonnement dans les plans E et H. 

Paramètres S (+paramètres z, y etc.).  

8. Discussion et exploitation des résultats par l’utilisateur. 

II.9   Exemple d’étape de simulation d’antenne Patch de fréquence 5GHz  

          La simulation de cette antenne est réalisée en utilisant le logiciel HFSS.  

   Ouvrir un nouveau projet et nommer le Project1 :  

 HFSS > Solution Type Terminal 

 

Figure II.12: Sélection de type de solution. 

 Choisir l’unité dans la fenêtre Modeler> Units > cm puis OK.  

 

 Figure II.13: Sélection des unités. 



Chapitre Ⅱ                                                                                                         Présentation du logiciel HFSS 

  

39 

 

II.9.1 Créer le substrat 

          Draw>Box ou clique sur  

          Pour dessiner le substrat, cliquer dans la barre d’outils. Dessiner alors une boîte. 

      En utilisant les surfaces d'entrées du même rang, entrer la position et dimension de Box 

comme montré dans la figure suivante : 

 

     Figure II.14: Position et dimensions de Box. 

        Ecrire le nom et choisir la matière de substrat :  

 

Figure II.15: Matière de substrat. 

Adapter la vue:  

Choisir dans le menu View> Fit All > Active View, ou appuyer sur les touches Ctrl +   

D (Raccourci). Le substrat est illustré dans la Figure II.16 :  
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Figure II.16: Substrat diélectrique. 

II.9.2 Créer le plan de masse  

Le plan de masse est illustré dans la Figure II.17 : 
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Figure II.17: Plan de masse (groundplane). 

II.9.3 Créer le Patch  

Draw>Rectangle  

 En utilisant les champs de saisie des coordonnées, entrez la position du rectangle : 

X : -0.925, Y: -0.69 , Z: 1.6 , appuyez sur la touche Entrée.  

En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle:  

           dx : 1.85, dy:1.38, dz: 1.6, appuyez sur la touche Entrée.  

La fenêtre des propriétés s’ouvre automatiquement entrez le nom: Patch  
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Figure II.18 : Création de patch. 

II.9.4   Créé le gap  

         Draw>Rectangle sur le patch 

  En utilisant les champs de saisie des coordonnées, entrez la position du rectangle : 

 X: -0.306, Y: 0.233, Z: 1.6, appuyez sur la touche Entrée.  

  En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle:  

            dx : 0.612, dy: 1.927, dz: 1.6, appuyez sur la touche Entrée.  

    La fenêtre des propriétés s’ouvre automatiquement entrez le nom: gap  
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 Patch > Ctrl + B(Raccourci) > gap >Modeler  >   Boolean >   Substract 

 

Figure II.19 : Création de gap. 

II.9.5   Crée le feed line 

Draw>Rectangle  

    En utilisant les champs de saisie des coordonnées, entrez la position du rectangle : 

  X: -0.153, Y:0.233, Z: 1.6, appuyez sur la touche Entrée.  

   En utilisant les champs de saisie des coordonnées, entrez le coin opposé du rectangle:  

             dx : 0.306, dy: 1.927, dz: 0.0, appuyez sur la touche Entrée.  

   La fenêtre des propriétés s’ouvre automatiquement entrez le nom: feed 
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Figure II.20: création de feed line. 

Patch > Ctrl + B(Raccourci) >feed >Modeler >   Boolean > Unite 

         

Figure II.21 : Dessin d’antenne.  
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II.9.6 Créé le port d'onde (wave port) 

             Draw> rectangle  

        En utilisant les champs de saisie des coordonnées, entrez la position  

        X: -0.153, Y: 2.16, Z: 0 Appuyez sur la touche Entrée.  

            À l'aide des champs de saisie des coordonnées, entrez le rayon du rectangle 

                   DX :0.306, dy: 0.0, dz: 1.6: Appuyez sur la touche Entrée.  

            Dans la fenêtre Propriétés nom: Port. Cliquez sur le bouton OK.  

 

Figure II.22: Création de port d'onde (wave port). 

II.9.7   Attribuer une excitation au port d’onde  

Sélectionnez: Port allez vers HFSS>Excitations>Assign>Wave Port  

Spécifié le nom: 1. Le terminal est 1 dans l'arborescence du projet.  

    

               Figure II.23 : Excitation wave-port.  
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II.9.8   Attribuer un champ perfect E pour le patch et le plan de masse 

Sélectionnez le patch > Ctrl + B(Raccourci) >groundplane > allez vers                                     

HFSS>Boundaries>Assign>Perfect E Nommé: PerfE 1 cliquez sur OK.  

 

Figure II.24 : Assignement de la condition "Conducteur parfait" pour le patch et plan 

de masse. 

II.9.9   Créer l’Air  

Cliquez sur Draw>Box  

        En utilisant les champs de saisie des coordonnées, entrez la position de la boîte  

       X: -3.8486, Y: -4.158, Z: -21.586, appuyez sur la touche Entrée.  

       À l'aide des champs de saisie des coordonnées, entrez le coin opposé de la boîte 

                    DX :7.0972, dy: 8.3172, dz: 43.172.  

        Définir le nom: AirBox. et le Matériel : vacuun  

Pour s'adapter à la vue: Cliquez sur View>Fit All>Active View  
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Figure II.25 : Boitier d’air. 

II.9.10   Créer une limite de rayonnement (Radiation Boundary)  

        Sélectionner Edit>Select objects>By Name on sélectionne: air  

    Pour créer une limite de rayonnement HFSS>Boundaries>Assign >Radiation  

           La boîte de dialogue des limites des rayonnements s'ouvre, nommé: Rad1  

                La radiation est illustrée ci-dessous:  

      

Figure II.26 : Assignement des frontières. 
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II.9.11   Créer une configuration du rayonnement (radiation setup)  

Pour définir la configuration de rayonnement  

HFSS>Radiation>Insert Far Field Setup>Infinite  

La boîte de dialogue Far Field Radiation Sphere Setup s'ouvre  

Sélectionnez l'onglet sphère infinie :  

      

Figure II.27 : Configuration du rayonnement. 

II.9.12   Créer une installation d'analyse (analysis setup)  

   Choisir « Add Solution Setup» dans le menu HFSS >Analysis Setup >Add 

Solution Setup. 

 Dans la Fenêtre de Solution Setup  

Cliquer sur la case General: 

• Solution fréquence: 5 GHz. 

• Nombre maximum de passes: 15. 

• Delta maximale: 0.02. 

  Cliquer sur le Bouton OK. 
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Figure II.28 : Solution d’analyse (fréquentielle). 

II.9.13   Ajouter le champ de fréquence (Add Frequency Sweep)  

  Pour ajouter un champ de fréquence, choisir (Add Sweep) dans le menu HFSS 

>Analysis Setup   >Add Sweep.  

 Choisir la solution pour installer: Setup1. Cliquer le bouton OK.  

La fenêtre du type de champ de fréquence s’active alors : Fast, Frequency Linear 

Count, Début: 1 GHz, Fin: 7 GHz, les points: 200. Clique OK.  

          

Figure II.29: Plage de fréquence et type d’analyse. 
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II.9.14   Analyse 

Pour valider le modèle:  

1. Choisir Check dans le menu HFSS > Validation > Check.  

2. Cliquer sur le Bouton Close.   

     

Figure II.30 : Vérification des étapes de simulation.  

Pour commencer le processus de solution:  

Choisir dans le menu HFSS >Analyze All  

 

        Figure II.31 : Commence de simulation. 

II.9 .15   Créer les rapports   

Après la simulation, pour créer le rapport de données de solution, il faut suivre les étapes 

suivantes : HFSS >Result>Create Repport.  
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Figure II.32: Affichage des résultats.  

Pour afficher le coefficient de réflexion S11 suivre les étapes suivantes comme 

illustré sur la Figure II.33.  

 

        Figure II.33: Affichage S11.  
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Pour afficher le rapport d'onde stationnaire VSWR suivre les étapes suivantes comme 

illustré sur la Figure II.34. 

 

 Figure II.34: Affichage VSWR.  

Le diagramme de rayonnement est obtenu en suivant les étapes suivantes:  

 

Figure II.35: Affichage de diagramme de rayonnement.  
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Figure II.36: Affichage de Gain. 

Les résultats de simulation de cette antenne (S11, VSWR et diagramme de rayonnement) 

sont mentionnés au chapitre 3.  

II.9 .16   Comment créer une fente forme L dans le plan de masse  

             Draw> rectangle1 sur la masse   

           En utilisant les champs de saisie des coordonnées, entrez la position  

                          X: -1.6, Y: -1.8, Z: 0 Appuyez sur la touche Entrée.  

          À l'aide des champs de saisie des coordonnées, entrez le rayon du rectangle 

                         dx :3.5 cm, dy:3.2 cm, dz: 0.17 cm: Appuyez sur la touche Entrée.  

           Dans la fenêtre Propriétés nom: rectngle1. Cliquez sur le bouton OK. 

           Draw> rectangle2 sur le patch 

           En utilisant les champs de saisie des coordonnées, entrez la position 

         X: -1.6, Y: -1.7, Z: 0 Appuyez sur la touche Entrée.  

          À l'aide des champs de saisie des coordonnées, entrez le rayon du rectangle 

         dx :3.2 cm, dy:2.75 cm , dz: 0.17 cm: Appuyez sur la touche Entrée. 

           Dans la fenêtre Propriétés nom : rectangle2. Cliquez sur le bouton OK.                 
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Pour créer le forme L :  

 rectangle1> Ctrl + B (Raccourci) > rectangle2>Modeler  >   Boolean >unite.    

 groundplan > Ctrl+B(Raccourci) >rectangle1>Modeler >  Boolean >   Substract. 

 

                               Figure II.37: Antenne patch avec fente forme L. 

    Pour définir les variables :  

                Cliquez sur Optimitrics>Add>Parametrics  

                 Cliquez sur Add  

                          ys=0.17 cm, début :0.05 cm, fin :0.3cm, le pas :0.01cm                    

 

Figure II.38: Edit variables. 
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II.10   Conclusion  

  Dans ce chapitre, nous avons présenté des informations sur un logiciel (HFSS) et 

expliqué les différentes étapes de création d'un design HFSS ainsi que la description générale 

des différents outils : barre d’outils, barres des menus, Fenêtre, Manager des projets, Etapes 

de simulation…etc. Nous avons pris un exemple de simulation d’antenne patch de fréquence 

5GHz, Après cette présentation nous Sommes désormais prêts à passer à la réalisation du 

projet, ce que nous aborderons dans le troisième chapitre. 
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Ⅲ.1 Introduction :        

            Dans le paysage dynamique des communications sans fil, la recherche et le 

développement d'antennes patch planaires équipées de réseaux de fentes ont pris une 

importance croissante. Cette approche innovante représente une avancée significative pour 

répondre aux besoins croissants des applications de communication multifréquence. En 

intégrant judicieusement des fentes dans la structure de la masse, ces antennes peuvent être 

conçues pour résonner à plusieurs fréquences distinctes. Cette capacité offre une solution 

élégante et efficace pour les systèmes de communication modernes, qui exigent des 

performances robustes et polyvalentes sur un large spectre de fréquences.  

Notre objectif principal est de concevoir une antenne inset feed qui résonne à une 

fréquence de 5 GHz, puis modifier de la géométrie de l'antenne pour obtenir une antenne 

multifréquence. 

Ce chapitre est divisé en plusieurs sections. Tout d'abord, nous présentons les 

caractéristiques et les spécifications de l'antenne de base, expliquant les principes de 

conception utilisés pour atteindre la résonance à 5 GHz.  

Ensuite, nous décrivons la technique utilisée pour obtenir une antenne multifréquence.  

Ce chapitre est structuré en trois parties distinctes, qui sont les suivantes :  

 Antenne I : Conception d'une antenne patch conventionnelle avec une fréquence de 

résonance de 5GHz.  

Antenne II : Amélioration des performances de l'antenne identifiée précédemment en 

concevant une autre antenne patch multifréquence avec l'ajout de réseaux des fentes dans le 

plan de masse. (2 fentes sous forme L). 

 Antenne III : Amélioration des performances de l'antenne patch en concevant une 

autre antenne patch multifréquence avec l'ajout de réseaux des fentes dans le plan de masse. 

(4 fentes sous forme L). 
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Ⅲ.2 Conception d'une antenne patch conventionnelle avec une fréquence 

de résonance de 5GHz  

La sélection effectuée concerne une antenne patch à alimentation insérée (inset feed) 

est un type d'antenne où la ligne d'alimentation est insérée directement dans le substrat de 

l'antenne patch plutôt que d'être située sur son bord.  

L'antenne patch elle-même est généralement constituée d'un conducteur métallique, 

souvent sous forme de patch rectangulaire, imprimé sur un substrat diélectrique de type FR4 

qui possède une permittivité relative (ɛr) de 4.4, une tangente de pertes (tan δ) de 0.02, et une 

épaisseur (h) de 1.6mm, le plan de masse est situé sur la face inférieure du substrat. 

La ligne d'alimentation est introduite dans le substrat à une certaine distance par 

rapport au bord du patch, généralement à travers une fente ou une ouverture dans le substrat.  

Les antennes patch à alimentation insérée sont largement utilisées dans les applications 

de communication sans fil, telles que les réseaux locaux sans fil (WLAN), les systèmes de 

communication par satellite, les systèmes de communication mobiles, etc., en raison de leur 

faible profil, leur facilité de fabrication et leur performance fiable. 

       

(a) : la face arrière.                                   (b) : la face avant. 

Figure III.1 : Géométrie de l’antenne patch de 5 GHz à (a) et (b). 

         Les paramètres de l'antenne patch de fréquence de fonctionnement de 5 GHz sont 

illustrés dans le Tableau III.1. 
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                    Tableau III.1 : Paramètres géométriques de l’antenne patch 5GHz. 

III.2.1 Résultats de Simulations  

       Dans cette section nous présentons les performances de l’antenne conventionnelle à 

savoir :  coefficient de réflexion S11, bande passante, VSWR, diagrammes de rayonnement, et 

gain.  

         III.2.1.1 Coefficient de réflexion (S11)  

      Le coefficient de réflexion souligne la capacité de l'antenne à absorber l'énergie. Il permet 

de déterminer les discontinuités présentées par l'antenne, ce paramètre permet de définir 

l'ajustement de l'antenne. 

      Selon les normes, le coefficient de réflexion doit être inférieur à -10dB et il représente le 

taux de réflexion des ondes statiques sur la structure. 

        

Figure III.2 : Coefficient de réflexion S11(dB) de l’antenne patch de 5 GHz. 

Paramètre Valeur (mm) 

Longueur du patch  (L) 18.5 

Largeur du patch (W) 13.8 

Longueur du substrat (Lg) 43.2 

Largeur du substrat (Wg) 37 

Hauteur du substrat (h) 1.6 

Longueur du feed (Lf) 19.27 

Largeur du feed  (Wf) 3.06 

Inset Distance (D) 2.134 

Inset Gap (G) 1.529 
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       La figure III.2 illustre le coefficient de réflexion S11 en fonction de la fréquence pour 

une antenne conventionnelle opérant à 5 GHz. Une diminution progressive de S11 est 

observée à mesure que la fréquence augmente, indiquant une meilleure adaptation 

d'impédance de l'antenne à la fréquence de fonctionnement. La valeur de -12,96 dB atteinte 

suggère une réduction significative des ondes réfléchies par l'antenne, témoignant ainsi d'une 

bonne correspondance d'impédance avec le milieu de transmission. La bande passante de 

l'antenne est de 100 MHz, maintenant le coefficient de réflexion en dessous de -10 dB sur 

cette plage de fréquences, assurant une performance satisfaisante sur une gamme étendue de 

fréquences. 

                          BP=  𝒇𝟐–  𝒇𝟏= 5.07 – 4.97 = 100 MHz. 

          III.2.1.2 Rapport d’Onde Stationnaire  

           Le Rapport d’Onde Stationnaire (VSWR) évalue l'adaptation d'une antenne à une ligne 

de transmission en comparant les valeurs maximale et minimale de tension le long de la ligne, 

révélant les réflexions d'impédance. Un VSWR idéal est de 1, signifiant une transmission sans 

perte d'énergie. Ce ratio varie entre 1 et l'infini. En pratique, une adaptation optimale est 

obtenue lorsque le VSWR est compris entre 1 et 2. 

     

      Figure III.3 : Rapport d'onde stationnaire (VSWR) en fonction de la fréquence de 

l’antenne patch 5 GHz.  

Figure III.3 montre que la valeur de VSWR de l'antenne est de 1.58, ce qui est inférieur 

à 2. Cela indique une bonne adaptation de l'antenne à la ligne de transmission, avec des pertes 

de réflexion minimales et une transmission efficace de l'énergie. Un VSWR inférieur à 2 est 
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généralement considéré comme acceptable pour la plupart des applications, garantissant des 

performances optimales de l'antenne et réduisant le risque de dommages aux composants du 

système. 

         III.2.1.3 Diagramme de rayonnement   

Les diagrammes de rayonnement en 2D et 3D représentent graphiquement les 

caractéristiques de rayonnement d'une antenne, montrant la distribution spatiale de l'énergie 

émise. Ils sont essentiels pour comprendre les performances et le comportement de l'antenne. 

Le rendement des antennes à polarisation linéaire est habituellement décrit en termes 

des deux plans E et H. Le plan E est défini comme étant le plan contenant le vecteur champ 

électrique et la direction du rayonnement maximal tandis que le plan H est défini comme étant 

le plan contenant le vecteur champ magnétique et la direction du rayonnement maximal.  

 

(a)                                                                  (b) 

Figure III.4: Diagramme de rayonnement en 2D et 3D de l’antenne patch de 5 GHz à (a) et 

(b) respectivement.   

         Figures III.4 représente le diagramme de rayonnement 2D et 3D d'une antenne 

conventionnelle, exposant la répartition spatiale de l'énergie rayonnée dans diverses 

directions. La présence d'un lobe principal et presque omnidirectionnel suggère que l'antenne 

émet principalement dans une direction spécifique tout en couvrant un large angle autour de 

cette direction, facilitant ainsi une transmission ou une réception efficace des signaux dans 

cette direction prédominante tout en offrant une certaine couverture dans les directions 

adjacentes. 
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         Le gain acceptable, évalué à 5.16 dB démontre que l'antenne concentre efficacement 

l'énergie rayonnée dans la direction du lobe principal par rapport à une antenne de référence 

idéale. Cela atteste de la performance satisfaisante de l'antenne pour la transmission ou la 

réception des signaux dans la direction souhaitée. 

         Les résultats de simulation peuvent être résumés dans le tableau suivant : 

Fréquence de 

résonance 

(GHz) 

Coefficient de 

réflexion 11 

(dB) 

Bande 

passante 

(MHz) 

Taux d’onde 

stationnaire 

VSWR 

Gain 

(dB) 

Domaine 

d’utilisation 

 

5 -12.96 100 1.58 5.16 WI-FI 

Tableau III.2: Résultats de simulation d’antenne conventionnelle (5GHz). 

III.3   Conception d'une antenne patch inset feed à réseaux des fentes (2L) 

      Pour augmenter le nombre de fréquences de résonances de l'antenne patch précédente, des 

modifications ont été effectuées en découpant un réseau de fentes étroites en forme de 2L (L 

et de L inversé) dans le plan de masse. Ces ajustements introduisent des éléments réactifs 

supplémentaires, permettant à l'antenne de fonctionner sur plusieurs fréquences, comme 

illustré dans la Figure III.5. 

 

 

 

 

 

 

 

 

 

(a) : la face arrière.                                         (b) :la face avant. 

Figure III.5 : Géométrie de l’antenne patch avec deux fentes en forme de L à (a) et (b). 
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III.3.1 Etude paramétrique (impact de l'élimination des fentes dans le plan de masse) 

            Différentes combinaisons de dimensions de fentes sont découpées sur la masse, telles 

que décrites dans le Tableau III.3. Les dimensions des fentes sont optimisées afin d'améliorer 

l'opération multifréquence. Les résultats des paramètres sont présentés graphiquement et 

détaillés dans la section suivante. 

Fente 1 Fente 2 

Paramètre    Intervalle (Cm) Paramètre Intervalle (Cm) Le pas (Cm) 

Longueur(Y1)      0.2≤ Y1 ≤3.5 Longueur (Y2)     0.2≤ Y2 ≤3.5     1.5 

Largeur(X1)      0.2≤ X1 ≤3.2 Largeur(X2)     0.2≤ X2 ≤3.2     1.2 

Epaisseur (YS1)      0.05≤ Ys1 ≤0.3 Epaisseur (YS2)     0.05≤ YS2 ≤0.3     0.01 

Tableau III.3: Dimensions des fentes (largeur x longueur). 

       

Figure III.6 : S11 (dB) en fonction de la fréquence pour différentes longueurs de 

fentes, correspondant aux dimensions indiquées dans le Tableau III.3. 

           Comme illustré dans la Figure III.6, une série de courbes de coefficient de réflexion a 

été obtenue grâce à une étude paramétrique. Pour sélectionner les courbes présentant un 

comportement multifréquence, nous avons développé un programme à l'aide du logiciel 

MATLAB. Ce programme offre la possibilité de choisir parmi différents comportements, 

incluant ceux à triple, quadruple, quintuple et sextuples bande, comme indiqué dans le 

diagramme organisationnel de la Figure III.7. Les résultats de cette analyse sont représentés 

dans la section suivante. 
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Figure III.7 : Organigramme MATLAB : Analyse des comportements multifréquences. 

Après avoir chargé la base de données, nous ballions les 280 courbes de S11 qui constituent 

cette base.  

Condition_1 : On cherche les courbes qui coupe la droite de -10dB en six, huit, dix et douze 

points, cette condition est utilisée pour trouver les géométries des antennes qui ont un 

comportement triple, quadruple, quintuple et sextuple bande (voir Figure III.7). Si la courbe 

coupe -10dB en 2 ou 4 points par exemple le comportement est mono ou double bandes 

respectivement.  
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Condition_2 : est utilisée pour optimiser les valeurs de coefficient de réflexion. On cherche 

un comportement triple, quadruple, quintuple et sextuple bandes dont les valeurs de S11 pour 

les trois, quatre, cinq et six bandes sont inférieurs à-11dB.  

  Ensuite, on cherche les valeurs de X et Y qui correspondent au meilleur comportement triple, 

quadruple et quintuple, sextuple bandes.   

         Le script filtre les courbes pour sélectionner celles qui répondent de manière optimale à 

nos besoins. Après cette sélection, il est constaté que l'antenne avec un réseau de fentes en 

forme de 2L présente un comportement multifréquence, permettant d'obtenir des bandes, 

triples, quadruples et quintuples. 

a. Triples Bandes : 

         Pour sélectionner les courbes présentant un comportement triple bande, le script doit 

satisfaire les conditions suivantes : les courbes doivent avoir un coefficient de réflexion 

inférieur à -10 dB et couper la ligne des -10 dB en six points afin d'obtenir trois fréquences de 

résonance. La figure III.8 montre la courbe choisie par le programme MATLAB, qui démontre 

un comportement triple bande. Cette courbe est compatible avec les dimensions suivantes : 

Fente 1 : longueur de 3.5 cm, largeur de 3.2 cm et épaisseur de 0.17cm. 

Fente 2 : longueur de 3.2 cm, largeur de 2.75 cm et épaisseur de 0.17 cm. 

         Ces dimensions ont été sélectionnées en fonction des résultats de l'analyse effectuée et 

peuvent être utilisées pour évaluer et discuter des performances de l'antenne en utilisant les 

programmes HFSS. 

   

Figure III.8: S11 (dB) en fonction de la fréquence pour un Comportement Triple 

Bande (Sélectionné par MATLAB). 
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      Figure III.9: S11 (dB) en fonction de la fréquence pour un Comportement Triple Bande 

(simulé par HFSS). 

          La figure III.9 représentent les variations du coefficient de réflexion (en dB) en fonction 

de la fréquence (en GHz). On observe trois pics de résonance pour S11 < -10 dB. L’antenne 

optimisée présente les trois bandes de fréquences suivantes:   

• 𝑓1 = 2.02 GHz (𝑆11=− 21.50𝑑𝐵), une bande passante de 2.06-1.96=110 MHz   

• 𝑓2 = 3.21 GHz (𝑆11=− 15.27𝑑𝐵), une bande passante de 3.27-3.18=90 MHz.  

• 𝑓3 = 6.31 GHz (𝑆11=− 20.51𝑑𝐵), une bande passante de 6.42-6.19=230 MHz.  

        On constate que, pour les trois fréquences, le coefficient de réflexion S11 est excellent et 

les bandes passantes sont très acceptables. 

           Rapport d’onde stationnaire   

        

Figure III .10: Rapport d'onde stationnaire en fonction de la fréquence pour un 

Comportement triple bande. 
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      La Figure III.10 montre le diagramme du VSWR en fonction de fréquence pour 

l'antenne triple bande optimisée. Cette dernière présente des valeurs de VSWR de 1.18, 1.41 

et 1.20 aux fréquences centrales de 2.02 GHz, 3.21 GHz et 6.31 GHz respectivement. Les 

résultats obtenus démontrent que l'antenne résonne dans la limite du VSWR qui se situe 

entre 1 et 2 ce qui indique qu'une bonne adaptation d'impédance entre la ligne d'alimentation 

de l'antenne et le patch rayonnant est obtenue. 

Diagramme de rayonnement  

  

(a) : 2.02GHz (b) : 3.21 GHz    

 

          (c) : 6.31GHz  

Figure III.11 :  Les diagrammes de rayonnement de la conception de la Figure III.5 à (a) 

2.02 GHz (b) 3.21 GHz (c) 6.31 GHz. 

          D'après les Figures III.11 (b) et (c), on remarque que le rayonnement de l'antenne pour 

les fréquences de 3,21 GHz et 6,31 GHz est concentré dans un lobe principal orienté vers la 

verticale du patch, avec des gains très acceptables de 8,75 dB et 3,94 dB respectivement. En 
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revanche, la Figure III.11 (a) révèle que pour la fréquence de 2,02 GHz, le rayonnement de 

l'antenne est divisé en deux lobes secondaires, avec un gain plus modéré de 1,52 dB. Ces 

observations mettent en évidence le comportement directionnel de l'antenne, avec des 

performances de gain adaptées à différentes fréquences de fonctionnement. 

         Les performances de l’antenne triple bande avec réseaux des fentes (2L) sont résumées 

dans le Tableau III.4 

Fréquence de 

résonance (GHz)  

Coefficient de 

réflexion 11 (dB)  

Bande  

passante  

(MHz)  

Taux d’onde  

stationnaire 

VSWR (dB)  

Gain  

(dB)  

2.02 -21.50 110  1.18   1.528 

3.21 -15.27  90 1.40  8.75 

6.31 -20. 51 230 1.20 3.94 

 

       Tableau III.4 : Performances de l’antennes triple bande avec deux fentes L. 

        L’utilisation de chaque fréquence est illustrée dans le tableau suivant :  

Bande de fréquence  

(GHz)  

Nom  Service  satellitaires  

2.02 ϵ [ 2 à 4  GHz]  Bande  S Diffusion de TV, radio, données 

3.21 ϵ [ 2 à 4 GHz]  Bande S Diffusion de TV, radio, données 

  6.31 ϵ [ 4 à 8 GHz]  Bande C  Diffusion de radio, données, TV, mobiles. 

Tableau III.5: Bandes de fréquences et utilisations.  

b. Quadruples bandes: 

            Dans cette section, nous avons sélectionné les courbes qui coupent la ligne de -10 dB 

en 8 points afin d'obtenir un comportement quadruple bande. La Figure III.12 représente la 

courbe obtenue par le programme MATLAB, laquelle est compatible avec les dimensions 

suivantes :  

Fente 1 : longueur de 3.5 cm, largeur de 3.2 cm et épaisseur de 0.23cm. 

Fente 2 : longueur de 3.2 cm, largeur de 2.75 cm et épaisseur de 0.23 cm. 
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           Ces dimensions ont été déterminées en tenant compte des résultats de l'analyse effectuée 

et peuvent servir à évaluer et à discuter des performances de l'antenne en utilisant les 

programmes HFSS. 

        

Figure III.12 :  S11 (dB) en fonction de la fréquence pour un Comportement quadruples 

bandes (Sélectionné par MATLAB). 

       

  Figure III.13 :  S11 (dB) en fonction de la fréquence pour un Comportement quadruples 

bandes (simulé par HFSS). 

           La courbe représentée dans la Figure III.13 illustre les variations du coefficient de 

réflexion en fonction de la fréquence pour l'antenne optimisée. On observe quatre pics de 

résonance où le coefficient de réflexion S11 est inférieur à -10 dB, indiquant une bonne 

adaptation d'impédance entre l'antenne et la ligne d'alimentation. Ces pics correspondent à 

quatre bandes de fréquences distinctes : 𝑓1 = 2,09 GHz, 𝑓2 = 3,28 GHz, 𝑓3 = 4,83 GHz et 



            Chapitre III                                                                                               Résultats et Simulation 

                     

70 

 

 𝑓4 = 6,41 GHz. Chaque bande de fréquences présente une valeur de S11 satisfaisante, 

respectivement -20,80 dB, -18,42 dB, -13,22 dB et -12,95 dB. De plus, les bandes passantes 

associées à chaque pic de résonance sont également indiquées, montrant des valeurs de 110 

MHz, 90 MHz, 300 MHz et 160 MHz respectivement. Globalement, ces résultats démontrent 

que l'antenne optimisée offre une performance remarquable avec des coefficients de réflexion 

excellents et des bandes passantes très acceptables pour les différentes fréquences de 

fonctionnement. 

        Rapport d’onde stationnaire   

 

Figure III.14 : Rapport d'onde stationnaire en fonction de la fréquence pour un 

Comportement quadruples bandes. 

       La Figure III.14 présente le diagramme du VSWR en fonction de la fréquence pour 

l'antenne optimisée quadruple bande. À 2,09 GHz, 3,28 GHz, 4,83 GHz et 6,41 GHz, les 

valeurs du VSWR sont respectivement de 1,20, 1,27, 1,55 et 1,58. Ces résultats indiquent que 

l'antenne résonne dans la plage souhaitée de VSWR, située entre 1 et 2, ce qui démontre une 

adaptation d'impédance efficace entre la ligne d'alimentation de l'antenne et le patch 

rayonnant. 
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Diagramme de rayonnement  

  

(a) : 2.09 GHz (b) : 3.28GHz  

 
 

(c) : 4.83GHz (d) : 6.41GHz 

Figure III.15 : Les diagrammes de rayonnement de la conception de la Figure III.5 à 

(a) 2.09 GHz, (b) 3.28 GHz (c), 4.83GHz et (d) 6.41GHz. 

           Le diagramme de rayonnement 3D de l'antenne offre une représentation visuelle 

précieuse de sa performance dans l'espace tridimensionnel. En examinant les Figures III.15 (c) 

et (d), on constate que le rayonnement de l'antenne est principalement concentré dans un lobe 

principal pour les fréquences de 4,83 GHz et 6,41 GHz, avec des gains modérés de 2,75 dB et 

3,78 dB respectivement. Cette concentration du rayonnement dans un lobe principal indique 

une direction privilégiée de transmission, ce qui peut être bénéfique dans certaines applications 

nécessitant une directivité spécifique. En revanche, les Figures III.15 (a) et (b) révèlent que 

pour les fréquences de 2,09 GHz et 3,28 GHz, le rayonnement de l'antenne est réparti entre 

deux lobes secondaires, avec des gains de 2,21 dB et 6,64 dB respectivement. Cette répartition 

en lobes secondaires peut être le résultat de la conception de l'antenne et de ses propriétés de 

propagation à différentes fréquences. Ces observations fournissent des informations cruciales 

pour comprendre le comportement directionnel de l'antenne et peuvent guider ses applications 

potentielles dans divers contextes de communication et de transmission de signaux. 



            Chapitre III                                                                                               Résultats et Simulation 

                     

72 

 

         Les performances de l’antenne quadruples bande avec réseaux des fentes (2L) sont 

résumées dans le Tableau III.6 

Fréquence de 

résonance 

(GHz)  

Coefficient de 

réflexion 11 (dB)  

Bande  

passante  

(MHz)  

Taux d’onde  

stationnaire 

VSWR (dB)  

Gain  

(dB)  

2.09 -20.80 110 1.20  2.21 

3.28 -18.42  90 1.27  6.64 

4.83 -13.22 300 1.55 2.75 

6.41 - 12.51 160 1.58 3.78 

Tableau III.6 : Performances de l’antennes quadruples bandes avec deux fentes L. 

 L’utilisation de chaque fréquence est illustrée dans le tableau suivant :  

Bande de fréquence  

(GHz)  

Nom  Service  satellitaires  

2.09 ϵ [ 2 à 4  GHz]  Bande  S Diffusion de TV, radio, données 

3.28 ϵ [ 2 à 4 GHz]  Bande S Diffusion de TV, radio, données 

4.83 ϵ [ 4 à 8 GHz] Bande C Diffusion de radio, données, TV, mobiles. 

   6.41 ϵ [ 4 à 8 GHz]  Bande C  Diffusion de radio, données, TV ,mobiles. 

Tableau III.7 : Bandes de fréquences et utilisations.  

c. Quintuples bandes: 

          Dans cette section, l'objectif est de rechercher un comportement quintuple bande, ce qui 

nécessite que les courbes coupent la ligne de -10 dB en 10 points. La Figure III.16 présente 

la courbe obtenue à l'aide du programme MATLAB, laquelle correspond à ce critère de 

sélection. Cette courbe est en accord avec les dimensions suivantes : 

Fente 1 : longueur de 3.5 cm, largeur de 3.2 cm et épaisseur de 0.14cm. 

Fente 2 : longueur de 3.2 cm, largeur de 2.75 cm et épaisseur de 0.14 cm. 

       Pour confirmer et étudier plus en détail les performances de l'antenne avec ces 

dimensions, une simulation est réalisée en utilisant le logiciel HFSS dont les résultats sont 

représentés par la Figure III.16. Cette simulation permet d'évaluer la réponse de l'antenne 

dans un environnement plus précis et de vérifier son comportement quintuple bande. 
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Figure III.16 : S11 (dB) en fonction de la fréquence pour un Comportement quintuples 

bandes (Sélectionné par MATLAB). 

 

Figure III.17 :  S11 (dB) en fonction de la fréquence pour un Comportement quintuples 

bandes (simulé par HFSS). 

          La figure III.17 représentent les variations du coefficient de réflexion (en dB) en 

fonction de la fréquence (en GHz). Nous pouvons observer cinq pics de résonance 

correspondant à cinq bandes de fréquences distinctes:   

 𝑓1 = 1.98 GHz (𝑆11 = − 15.06𝑑𝐵), une bande passante de 2.01-1.93= 80 MHz.  

 𝑓2 = 3.18 GHz (𝑆11 = − 15.45𝑑𝐵), une bande passante de 3.25-3.15=100 MHz.  

 𝑓3 = 4.58 GHz (𝑆11 = − 20.28𝑑𝐵), une bande passante de 4.75-4.48= 270 MHz.  

 𝑓4 = 6.20 GHz (𝑆11 = − 17.19𝑑𝐵), une bande passante de 6.32-6.12= 200 MHz. 

 𝑓5 = 7.43 GHz (𝑆11 = − 24.82𝑑𝐵), une bande passante de 7.50-7.35= 150 MHz.  
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        Ces résultats mettent en évidence la capacité de l'antenne à résonner efficacement sur une 

large gamme de fréquences, offrant ainsi une adaptabilité et une polyvalence significatives 

dans diverses applications de communication et de transmission de signaux. 

         Rapport d’onde stationnaire   

      

Figure III. 18 : Rapport d'onde stationnaire en fonction de la fréquence pour un 

Comportement quintuples bandes. 

         La Figure III.18 montre le diagramme du VSWR en fonction de la fréquence pour 

l'antenne quintuple bande optimisée. Les valeurs obtenues sont de 1,42 à 1,98 GHz, 1,40 à 3,18 

GHz, 1,21 à 4,58 GHz, 1,32 à 6,20 GHz et 1,12 à 7,43 GHz. Ces valeurs indiquent une très 

bonne adaptation d'impédance entre l'antenne et la ligne de transmission sur toutes les 

fréquences centrales mentionnées. 

         Un VSWR inférieur à 2 est généralement considéré comme acceptable et signifie que la 

majorité de la puissance est transférée de la ligne d'alimentation à l'antenne avec peu de 

réflexion. Les valeurs spécifiques observées ici (toutes inférieures à 1,5) suggèrent une 

performance exceptionnelle, notamment à 4,58 GHz et 7,43 GHz, où les valeurs de 1,21 et 1,12 

respectivement sont très proches de l'idéal théorique de 1. 

         Ces résultats montrent que l'antenne optimisée offre une excellente adaptation 

d'impédance sur toutes les bandes de fréquences centrales, maximisant ainsi l'efficacité de 

transmission et minimisant les pertes de signal. Par conséquent, cette antenne est bien adaptée 

pour des applications nécessitant une couverture multibande avec des performances élevées et 

fiables. 
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Diagramme de rayonnement  

  

(a) : 1.98GHz        (b) : 3.18 GHz  

 
 

(c) : 4.58 GHz (d) : 6.20GHz 

 

(e) : 7.43GHz  

Figure III.19 : Les diagrammes de rayonnement de la conception de la Figure III.5 à (a) 

1.98 GHz,(b) 3.18 GHz, (c)  4.58GHz , (d) 6.20GHz et (e)7.43 GHz . 

         Les diagrammes de rayonnement de l'antenne présentés dans la Figure III.19 révèlent des 

caractéristiques distinctes selon la fréquence. À 1.98 GHz, le rayonnement est réparti entre 

deux lobes secondaires avec un gain de 2.54 dB, indiquant une distribution moins focalisée. En 

revanche, à des fréquences plus élevées (3.18 GHz, 4.58 GHz, 6.20 GHz et 7.43 GHz), le 
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rayonnement se concentre principalement dans un lobe principal. Les gains varient 

respectivement de 1.13 dB, 4.05 dB, 2.03 dB à 7.07 dB, avec une efficacité de transmission 

accrue à mesure que la fréquence augmente. Notamment, à 7.43 GHz, le gain élevé de 7.07 dB 

suggère une excellente efficacité pour des applications nécessitant une transmission 

directionnelle avec des performances élevées.  

         En résumé, l'antenne est adaptée pour des applications à couverture directionnelle accrue, 

surtout à des fréquences plus élevées.  

        Les performances de l’antenne quintuple bande avec réseaux des fentes en forme de (2L) 

sont résumées dans le Tableau III.8 

Fréquence de 

résonance 

(GHz)  

Coefficient de 

réflexion 11 (dB)  

Bande  

passante  

(MHz)  

Taux d’onde  

stationnaire 

VSWR (dB)  

Gain  

(dB)  

1.89 -15.06 80 1.42  2.54 

3.18 -15.45  100 1.40  1.13 

4.58 -20.28 270 1.21 4.05 

6.20 - 17.19 200 1.32 2.03 

7.43 -24.82 150 1.12 7.07 

      Tableau III.8 : Performances de l’antennes quintuple bande avec deux fentes L. 

       L’utilisation de chaque fréquence est illustrée dans le tableau suivant :  

Bande de 

fréquence (GHz)  

Nom  Service  satellitaires  

 1.89 ϵ [ 1 à 2 GHz]  Bande  L        Communication mobiles (marine, aviation,    

terrestres..) 

3.18 ϵ [ 2 à 4 GHz]  Bande S         Diffusion de TV, radio, données 

4.58 ϵ [ 4 à 8 GHz] Bande C  Diffusion de radio, données, TV, mobiles. 

 6.20 ϵ [ 4 à 8 GHz]  Bande C  Diffusion de radio, données, TV, mobiles. 

 7.43 ϵ [ 4 à 8 GHz] Bande C Diffusion de radio, données, TV, mobiles. 

Tableau III.9 : Bandes de fréquences et utilisations. 
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III.4   Conception d'une antenne patch inset feed à réseaux des fentes (4L) 

      Dans cette section, nous présentons l'étude et la conception d'une antenne optimisée en 

augmentant le nombre de fentes. Nous avons intégré un réseau de fentes étroites en forme de 

4L (composées de 2L et de 2L inversé) sur la masse afin d'optimiser les performances de 

l'antenne. Cette approche permet d'améliorer significativement les caractéristiques de 

l'antenne en augmentant le nombre de bandes de fréquence prises en charge. En exploitant 

cette configuration spécifique des fentes, nous visons à obtenir une antenne plus performante, 

capable de répondre à une plus large gamme de besoins en termes de fréquences. 

    La géométrie de l'antenne à réseau de fentes en forme de 4L est illustrée à la Figure III.20. 

               

             Figure III.20 : Géométrie de l’antenne patch avec quatre fentes en forme de L. 

III.4.1 Etude paramétrique (impact de l'élimination des fentes dans le plan de masse) 

       Dans cette étude, différentes combinaisons de dimensions de fentes sont soigneusement 

sélectionnées et intégrées sur la masse de l'antenne, comme indiqué dans le Tableau III.10. 

Ces dimensions sont minutieusement optimisées pour permettre un fonctionnement efficace 

sur plusieurs fréquences. L'objectif est d'améliorer la performance globale de l'antenne, en 

permettant une couverture plus large de bandes de fréquences.  

      Les résultats obtenus sont présentés de manière graphique et détaillée dans la section 

suivante, fournissant ainsi une analyse approfondie des paramètres clés et de leur impact sur 

les performances de l'antenne. 
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Fente 1 Fente 3 

Paramètre       Intervalle (Cm) Paramètre Intervalle (Cm) Le pas (Cm) 

Longueur (Y1)    2 ≤ Y1  ≤3.5    Longueur (Y3)    2 ≤ Y3≤3.5 1.5 

Largeur(X1)    2 ≤ X1  ≤3.2    Largeur(X3)    2 ≤ X3 ≤3.2 1.2 

Epaisseur (YS1)    0.05 ≤Ys1  ≤0.3   Epaisseur (YS3)    0.05 ≤ Ys3 ≤0.3 0.05 

Fente 2 Fente 4 

Paramètre       Intervalle (Cm) Paramètre  Intervalle (Cm) Le pas (Cm) 

Longueur (Y2)  1.8 ≤ Y2 ≤2.8 Longueur (Y4)   1.8 ≤ Y4 ≤2.8 0.8 

Largeur(X2)  1.4 ≤ X2 ≤2.4 Largeur(X4)   1.4 ≤ X4 ≤2.4 0.4 

Epaisseur (YS2)  0.05 ≤ Ys2 ≤0.3 Epaisseur (YS4)   0.05 ≤ Ys4 ≤0.3 0.05 

Tableau III.10 : Dimensions des fentes (largeur x longueur).    

 

Figure III.21 : S11 (dB) en fonction de la fréquence pour différentes longueurs de 

fentes, correspondant aux dimensions indiquées dans le Tableau III.10. 

Dans le cadre de cette étude, une série de courbes de coefficient de réflexion a été générée 

via une analyse paramétrique, comme indiqué dans la Figure III.21. Afin de distinguer les 

courbes présentant un comportement multifréquence, un programme spécifique a été élaboré 
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en utilisant le logiciel MATLAB. Ce programme permet de sélectionner parmi diverses 

courbes celles qui exhibent un tel comportement. La courbe choisie par ce programme 

montre un comportement à sextuple bande, comme illustré dans la Figure III.22, où elle 

coupe la ligne de -10 dB en 12 points.   

    

Figure III.22 : S11 (dB) en fonction de la fréquence pour un comportement sextuple bande 

(Sélectionné par MATLAB). 

          La courbe obtenue à l'aide du programme MATLAB, répondant aux critères de sélection 

définis, révèle des dimensions spécifiques pour l'antenne, avec les dimensions de fentes 

suivantes: 

Fente 1 : longueur de 3.5 cm, largeur de 3.2 cm et épaisseur de 0.07cm. 

Fente 2 : longueur de 3.2 cm, largeur de 2.75 cm et épaisseur de 0.07 cm. 

Fente 3 : longueur de 2.8 cm, largeur de 2.4 cm et épaisseur de 0.07 cm. 

Fente 4 : longueur de 2.4 cm, largeur de 2 cm et épaisseur de 0.07 cm. 

        Pour approfondir l'analyse des performances de l'antenne avec ces dimensions, une 

simulation a été réalisée à l'aide du logiciel HFSS. Les résultats de cette simulation sont illustrés 

par la Figure III.23. Cette simulation permet d'évaluer la réponse de l'antenne dans un 

environnement plus précis et de vérifier son comportement en mode sextuple bande, assurant 

ainsi une compréhension détaillée et une validation rigoureuse des caractéristiques de l'antenne. 



            Chapitre III                                                                                               Résultats et Simulation 

                     

80 

 

    
Figure III.23 : S11 (dB) en fonction de la fréquence pour un comportement sextuple bande 

(simulé par HFSS). 

         Dans la figure III.23, nous analysons les bandes de fréquences où l'antenne optimisée 

montre une bonne performance. À 2.37 GHz, avec une valeur de S11 de -17.47 dB et une bande 

passante de 110 MHz, l'antenne présente une bonne adaptation d'impédance, indiquant une 

faible réflexion. À 3.11 GHz, avec un S11 de -18.15 dB et une bande passante de 80 MHz, la 

performance est encore meilleure, avec une réflexion minimale. 

         À 4.16 GHz, S11 atteint -18.54 dB avec une bande passante de 120 MHz, indiquant une 

excellente transmission de la puissance. À 5.88 GHz, la valeur de S11 est extrêmement faible 

à -30.09 dB, avec une bande passante de 200 MHz, signifiant une quasi-absence de réflexion 

et une performance optimale.        

          À 6.48 GHz, malgré une valeur de S11 légèrement plus élevée à -12.91 dB, l'antenne 

offre une bande passante de 110 MHz, avantageuse pour des applications nécessitant une large 

couverture de fréquence. Enfin, à 7.82 GHz, avec un S11 de -23.28 dB et une bande passante 

de 340 MHz, l'antenne montre une très bonne adaptation d'impédance et une faible réflexion 

sur une large bande de fréquence.  

          Globalement, les valeurs de S11 inférieures à -10 dB pour toutes les bandes indiquent 

une bonne adaptation de l'antenne, permettant une transmission efficace de la puissance. Les 

bandes passantes variées de 80 MHz à 340 MHz montrent une couverture de fréquence large 

et optimale pour des applications multibandes.  

           Les très faibles valeurs de S11 à 5.88 GHz et 7.82 GHz démontrent une performance 

optimale, particulièrement utile pour des applications nécessitant une efficacité maximale. En 

conclusion, l'antenne optimisée présente une excellente performance sur les six bandes de 



            Chapitre III                                                                                               Résultats et Simulation 

                     

81 

 

fréquences indiquées, avec une très bonne adaptation d'impédance et des bandes passantes 

variées, permettant une utilisation efficace dans des applications multibande. 

        Rapport d’onde stationnaire   

          

Figure III.24: Rapport d'onde stationnaire en fonction de la fréquence pour un 

Comportement sextuple bande. 

         Dans la figure III.24, nous analysons les valeurs de VSWR aux fréquences centrales 

des différentes bandes où l'antenne optimisée montre une bonne performance. À 2.37 GHz, 

avec une valeur de VSWR de 1.30, l'antenne présente une bonne adaptation d'impédance. À 

3.11 GHz, une valeur de VSWR de 1.28 indique une réflexion minimale. À 4.16 GHz, une 

valeur de VSWR de 1.26 suggère une excellente transmission de puissance. À 5.88 GHz, 

une valeur de 1.06 indique une performance optimale. À 6.48 GHz, une valeur de 1.58 

montre une bonne adaptation malgré une réflexion légèrement supérieure. À 7.82 GHz, une 

valeur de 1.14 indique une très bonne adaptation. Globalement, les valeurs de VSWR 

proches de 1 montrent une bonne adaptation sur toutes les fréquences, permettant une 

transmission efficace de la puissance. 
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Diagramme de rayonnement  

 

 

        (a) : 2.37GHz           (b) : 3.11GHz 

  

       (c) :4.16GHz           (d) : 5.88GHz  

  

      (e) : 6.48GHz           (f) : 7.82GHz  

Figure III.25 :  Les diagrammes de rayonnement de la conception de la Figure III.20 à (a) 

2.37 GHz,(b) 3.11 GHz, (c)  4.16GHz , (d) 5.88GHz , (e) 6.48 GHz et (f) 7.82 GHz . 

         Les diagrammes de rayonnement de l'antenne, illustrés dans la Figure III.25, montrent 

des caractéristiques distinctes selon la fréquence. À 3.11 GHz, le rayonnement se divise en 

deux lobes secondaires avec un gain de 1.74 dB, indiquant une distribution moins focalisée. En 
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revanche, aux fréquences de 2.37 GHz, 4.16 GHz, 5.88 GHz, 6.48 GHz et 7.82 GHz, le 

rayonnement est principalement concentré dans un lobe principal. Les gains pour ces fréquences 

sont respectivement de 7.79 dB, 1.11 dB, 3.98 dB, 5.01 dB et 7.17 dB, ce qui montre une 

meilleure focalisation et une plus grande efficacité dans la direction principale. Cette variation 

de comportement entre les fréquences suggère que l'antenne offre une performance optimale en 

termes de directivité et de gain pour la plupart des fréquences. 

      Les performances de l’antenne sextuple bande avec réseaux de fentes en forme de 4L Sont 

résumées dans le Tableau III.11 

Fréquence de 

résonance 

(GHz)  

Coefficient de 

réflexion 11 (dB)  

Bande  

passante  

(MHz)  

Taux 

d’onde  

stationnaire 

VSWR (dB)  

Gain  

(dB)  

2.37 -17.47 110 1.30  7.79 

3.11 -18.15  80 1.28  1.74 

4.16 -18.54 120 1.26 1.11 

5.88 -30.09 200 1.06 3.98 

6.48 -12.91 110 1.58 5.01 

7.82 -23.28 340 1.14 7.17 

      Tableau III.11 : Performances de l’antennes sextuple bande avec quatre fentes L. 

        L’utilisation de chaque fréquence est illustrée dans le tableau suivant : 

Bande de fréquence  

(GHz)  

Nom  Service  satellitaires  

2.37 ϵ [ 2 à 4  GHz]  Bande  S       Diffusion de TV, radio, données  

3.11 ϵ [ 2 à 4 GHz]  Bande S       Diffusion de TV, radio, données 

4.16 ϵ [ 4 à 8 GHz] Bande C Diffusion de radio, données, TV, 

mobiles. 

       5.88 ϵ [ 4 à 8 GHz]  Bande C  Diffusion de radio, données, TV, 

mobiles. 

       6.48 ϵ [ 4 à 8 GHz] Bande C Diffusion de radio, données, TV, 

mobiles. 

       7.82 ϵ [ 4 à  8 GHz] Bande C Diffusion de radio, données, TV, 

mobiles. 

Tableau III.12 : Bandes de fréquences et utilisations. 
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Ⅲ.5 Conclusion   

             En conclusion, ce chapitre a démontré l'efficacité de la conception et de 

l'optimisation d'antennes patch multifréquences en utilisant des réseaux de fentes. Deux 

conceptions d'antennes ont été développées, chacune optimisée pour différentes bandes de 

fréquences. 

             La première conception, une antenne patch conventionnelle modifiée par l'ajout de 

fentes en forme de 2L, a montré des performances remarquables en termes de comportement 

triple, quadruple et quintuple bande. Cette antenne a été capable de fonctionner sur des 

fréquences variées, à savoir: 

 Triple bande : 2,02 GHz, 3,21 GHz et 6,31 GHz. 

 Quadruple bande : 2,09 GHz, 3,28 GHz, 4,83 GHz et 6,41 GHz. 

 Quintuple bande : 1,98 GHz, 3,18 GHz, 4,58 GHz, 6,20 GHz et 7,43 GHz. 

              Les analyses du VSWR et du S11 ont confirmé une adaptation d'impédance efficace 

sur ces bandes de fréquences, garantissant des performances optimales. 

           La deuxième conception a étendu cette approche en ajoutant un réseau de fentes de 

4L, permettant d'obtenir un comportement de six bandes de fréquences : 2,37 GHz, 3,11 

GHz, 4,16 GHz, 5,88 GHz, 6,48 GHz et 7,82 GHz. Les résultats ont montré une excellente 

adaptabilité sur ces six bandes, avec une bonne adaptation d'impédance et des performances 

de rayonnement directionnelles. 

         Ces conceptions démontrent que l'ajout et l'augmentation du nombre de fentes 

permettent d'augmenter le nombre de bandes de fréquences, offrant ainsi des solutions 

polyvalentes pour une variété d'applications de communication sans fil. En somme, ce travail 

souligne la capacité des antennes patch multifréquences à fournir des performances optimales 

en termes de directivité et de gain, tout en s'adaptant aux exigences spécifiques de chaque 

bande de fonctionnement.
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           Conclusion générale 

L'essor technologique rapide dans le domaine des télécommunications, incluant la 

téléphonie mobile, les réseaux sans fil, la télévision par satellite et les applications radar (civiles 

ou militaires), a entraîné des besoins accrus et une évolution technologique majeure des 

antennes. Pour répondre aux exigences croissantes en termes de gain, de largeur de bande 

passante, de coût et de taille, il est crucial de concevoir des antennes compactes et 

multifréquences. 

Ce mémoire s'est concentré sur la conception et l'amélioration d'antennes patch planaires 

intégrant des réseaux de fentes dans le plan de masse pour obtenir des comportements 

multifréquences. En particulier, deux configurations d'antennes multibandes ont été proposées 

et étudiées. 

 La première étape a impliqué la conception d'une antenne patch conventionnelle 

résonnant à 5 GHz, simulée à l'aide du logiciel HFSS. Cette conception de base a servi de 

référence pour les modifications ultérieures. Ensuite, deux géométries de fentes ont été 

incorporées dans le plan de masse : des fentes en forme de L et de L inversé, ainsi que des fentes 

en forme de 2L et de 2L inversé. Une analyse paramétrique a été réalisée pour évaluer les 

positions et les dimensions des fentes, puis elles ont été optimisées à l'aide d'un algorithme 

Matlab afin d'atteindre les performances désirées. 

Les résultats obtenus avec l'antenne à fentes en forme de L et L inversé ont montré des 

performances multifréquences notables : 

 Comportement triple bande : Des fréquences de résonance à 2,02 GHz, 3,21 GHz et 

6,31 GHz avec des gains directifs de 1,528 dB, 8,75 dB et 3,94 dB respectivement. 

 Comportement quadruple bande : Des fréquences de résonance à 2,09 GHz, 3,28 

GHz, 4,83 GHz et 6,41 GHz avec des gains directifs de 2,21 dB, 6,64 dB, 2,75 dB et 

3,78 dB respectivement. 

 Comportement quintuple bande : Des fréquences de résonance à 1,89 GHz, 3,18 GHz, 

4,58 GHz, 6,20 GHz et 7,43 GHz avec des gains de 2,54 dB, 1,13 dB, 4,05 dB, 2,03 dB 

et 7,07 dB respectivement. 

           La deuxième configuration, avec des fentes en forme de 2L et 2L inversé, a démontré un 

comportement à six bandes avec des fréquences de résonance à 2,37 GHz, 3,11 GHz, 4,16 
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GHz, 5,88 GHz, 6,48 GHz et 7,82 GHz, et des gains excellents de 7,79 dB, 1,74 dB, 1,11 dB, 

3,98 dB, 5,01 dB et 7,17 dB respectivement. 

     Les résultats obtenus indiquent que l'incorporation de réseaux de fentes dans le plan de 

masse est une solution prometteuse pour la miniaturisation des antennes et la création de 

plusieurs bandes de fréquences opérationnelles. Les antennes proposées sont ainsi bien adaptées 

à la couverture de plusieurs bandes de communication sans fil utiles (bande S, bande C et bande 

X), telles que les applications WiMax et WLAN. 

   Nous envisageons d’utiliser des plans de masse partiels dans la conception des antennes 

pour améliorer les bandes passantes et améliorer encore les performances multifréquences dans 

les travaux à venir. Cette approche pourrait offrir une flexibilité accrue et des solutions plus 

efficaces pour répondre aux besoins en constante évolution des systèmes de communication 

modernes. 
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